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Quick Start

1.1 List of Currently Supported Poker Rooms

America’s Cardroom (Winning Poker Network, USA-friendly, Windows 7 only)
Black Chip Poker (Winning Poker Network, USA-friendly, Windows 7 only)
True Poker (Winning Poker Network, USA-friendly, Windows 7 only)

5 Dimes Poker (Shark Tank room only, WPN, USA-friendly, Windows 7 only)
BetOnline Poker (Chico Poker Network, USA-friendly)

SportsBetting.ag (Chico Poker Network, USA-friendly)

Full Flush Poker (Equity Poker Network, USA-friendly)

Bodog Poker (including Chinese version)

Bovada Poker (USA-friendly version of Bodog)

888 Poker (including Spanish, Chinese, and New Jersey USA versions)
WSOP Poker (including UK, New Jersey, and Nevada versions)

William Hill Poker (iPoker network, EU license)

Ladbrokes Poker (iPoker network, EU license)

Betfair Poker (iPoker network, Danish license)

Titan Poker / TitanBet Poker (iPoker network)

Winner Poker (iPoker network)

NetBet Poker (formerly Poker770, iPoker network)

Bet365 Poker (iPoker network, EU license)

BetnGo Poker (iPoker network)

BetFred Poker (iPoker network)

Boyle Poker (iPoker network)

Paddy Power Poker (iPoker network)

Everest Poker (iPoker network)

Sisal.it (Italy-only iPoker software room, bot reads Italian here)

Titanbet.it (ltaly-only iPoker software room, bot reads Italian here)
PaddyPower.it (ltaly-only iPoker software room, bot reads Italian here)
Turbopoker.fr (France-only iPoker software room)

Everest Poker France (France-only iPoker software room)

888.es (Spain-only 888 software room)

Please note that our bot will not automatically work on other skins on the same network,
and must be specifically programmed to work at each site we support.

For Rakeback and special deposit bonus deals sign up for your poker room accounts
through this link:

http://tinyurl.com/I6x9cph



http://tinyurl.com/l6x9cph

1.2 Installation and Program Access

Unless you changed the path on the download screen, the bot was installed on
your c: drive to a folder named poker in a subfolder named data. Five files
came with the download and they should all be in that subfolder together.
Therefore the bot folder can be accessed by going to my computer and then
Local Disk C: and then opening the folder poker and then the subfolder data.

The bot itself is named holdembot and can be opened on an XP, Windows 7, or
Windows 8 machine by simply double-clicking it. On a Vista machine the bot
must be run as administrator. You can do this by right clicking on the bot and
choosing the Run As Administrator menu item in the pop up menu.

Run Poker Room Software ‘as Administrator’. On Vista, W7, and W8
machines you must start the poker room software to run as administrator. This is
done by right-clicking on the program icon and choosing the Run as
Administrator menu item in the pop up menu. Please note that you must do this
every time you start the poker room.

You can set the poker room (and the bot on Vista machines) to always run as
administrator by right-clicking on the program icon, choosing Properties, going
to the Shortcut tab, clicking on the Advanced button, and checking the box that
says Run as Administrator. If you do this once the program will then always run
as administrator, even when you open it in the usual manner.

Please note additional temporary files will appear in the bot folder once you open
the bot, including the bot’s own recorded session log (which is a text file titled
holdem and records everything the bot saw and did in the last session, and
gives a reason for each action taken).

Use of Desktop Icons: By default the installation program creates a shortcut
called “holdembot” on your desktop that can be used to start the bot. If you
choose to use the desktop program icon, we recommend renaming it. (The icon
image is generic-looking for stealth reasons.) To rename the shortcut: Right-click
on the icon and choose rename from the pop up menu. Think of a creative name
for it; perhaps something that sounds like another piece of software such as Mail
Grabber or Photo Editor.

A desktop shortcut makes program access convenient. A better solution than a
shortcut to the program, however, is a shortcut to the bot-folder itself. That way
you can have quick access to your profiles and session logs as well. To do this,
right-click on the bot folder (the ‘data’ subfolder inside the ‘poker’ folder) and
choose Send To and then choose Desktop (create shortcut). After the shortcut to



the folder appears on your desktop, rename it by right-clicking on it and choosing
Rename from the popup menu.

Windows 8. The bot will work on most Windows 8 computers (except for the
Winning Poker Network rooms) as long as you have it on the desktop view. Also
please make sure you have updated to Windows 8.1 or later. Here is a web page
that shows you how to do that:

http://www.pugetsystems.com/labs/articles/How-To-Make-Windows-8-1-Act-
More-Like-Windows-7-514/

You may also like to read this thread in our support forum where other Windows
8 users have reported on what they did to optimize it for the bot:

http://bonusbots.com/support/index.php/topic,7405.0.html

(You will need to log into our support forum first in order to access that board.
There is a lot more to our support forum than what is visible to guests —
including profile and add-on software marketplace boards — so make sure you
get registered there and log in to check it all out!)

Errors reported by bot on start-up: When you start the bot it will check your PC
display settings and give a numbered error message if they do not match those
required by the bot. Appendix A at the end of this document tells you how to
correct each of these errors. If you get any of these, please refer to Appendix A
to correct them before proceeding further.

Verify Bot Window Data: After doing the initial poker room software settings
adjustments described in section 1.3 below, put the bot in a low stakes cash
game, playing one table only, and keep the bot window open on your screen.
Watch closely and make sure accurate information is being reported in the bot
window data. Especially pay attention to the big blind size and your stack size
figures — if those are not being reported accurately, the bot will appear to play like
a maniac but it will be because the bot thinks your stack is extremely low. If the
information scrolls too fast for you to read it, you can close the bot and verify the
data in the bot’s session log (see section 3.5 for an explanation of how the
session log works and where to find it).

English Language Regional Settings in Windows. Our bot needs your
Windows language to be in English at most of our supported poker rooms (the
special Italian rooms supported are exceptions). From the Control Panel in
Windows, find the Language and Regional Options. Set this to English /
United States. (Please note that English / United Kingdom can cause problems
due to their using commas in place of decimals, so do not use that.)


http://www.pugetsystems.com/labs/articles/How-To-Make-Windows-8-1-Act-More-Like-Windows-7-514/
http://www.pugetsystems.com/labs/articles/How-To-Make-Windows-8-1-Act-More-Like-Windows-7-514/
http://bonusbots.com/support/index.php/topic,7405.0.html

If your native Windows language is not English and the bot does not report
the correct big blind size or stack size in the open bot window (or reports stack =
unknown) even after changing your Windows language to English/US, you may
also need to adjust your language for non-unicode programs. Here is the path
for doing that in Windows 7:

Control Panel >
Clock Language and Region >
Change Keyboards or other input methods > set keyboard language to English here
Administrative tab >
Language for non-unicode programs > here set this to English/US

Don’t forget to make sure your keyboard language is set to English /US on the
third step on the above path.

Poker room setup: The list of currently supported poker rooms is at the
beginning of this manual. The bot will usually not work at any other poker rooms,
even if they are a skin on the same network. Also, each supported poker room
requires some setup before the bot will work there (see below).

Do not attempt to run the bot before doing the necessary setup at the poker room
you want to play at. This is critical. If you don'’t fix error messages in the bot
window and do the required poker room setup, the bot may not be able to read
the cards or the situation properly - and as a result may appear to act erratically.

Anti-Virus and Anti-Spyware Warnings: If you get a warning message from
your anti-virus software about our program, it is a false positive. Some security
programs don't like the looks of our software. Rest assured our software is 100%
safe. We have been in business since 2006 and have over 10,000 members in
our support forum. Tell your Anti-virus to leave the bot folder alone and let our
script run (you may even need to disable the file shield function of your AV
program in order to run the bot).

If you get the error message that the .dll file is missing: This file comes in the
bot download and is necessary for the bot to work. It must be kept in the same
folder as the bot! If you get this message and you do indeed see that this file is
located inside the bot folder like it is supposed to be, that means your anti-virus
program is quarantining this file. You need to tell it leave the C:/Poker/Data file
alone. Here is a link that may help for Avast users:

https://support.avast.com/index.php? m=knowledgebase& a=viewarticle&kbarticleid=201

In particular, Avast!, Malwarebytes, Norton and Kaspersky are known to
guarantine the bot folder files without your permission. If you have those
applications running on your PC you may need to tell them to ignore the bot
folder.


https://support.avast.com/index.php?_m=knowledgebase&_a=viewarticle&kbarticleid=201

The alternative is to disable your anti-virus program, download the bot again, and
keep it disabled while you play.

English Only: Our poker bots can only read United States English (the special
Italian rooms supported are exceptions) so you must be using the English
versions of the poker room software. You must also adjust the following settings
on each individual poker room client.

If the only action the bot ever takes is folding even when the instructions in
the bot window say to raise or call, you may have a CPU configuration issue on
your PC that can be fixed by setting it to use only one core. The path for making
this adjustment is as follows:

START / All Programs / Accessories / Run >
In the Run window type in MSCONFIG and hit enter >
In the BOOT tab click on Advanced Options >
Put a tick in Number of Processors and setitto 1



1.3 Poker Room Settings

Winning Poker Network
(America’s Cardroom, Black Chip Poker, True Poker, 5 Dimes Shark Tank)

Note: Our bot only works with Windows 7 at this network, so if you have
Windows 8 you should use a VM. Also, it can currently play a maximum of 2-3
tables at these rooms (three on most desktops, two on most laptops). While you
can hook additional bot windows to tables, you will get “unable to read cards”
messages on one of the tables if you attempt to play 4+ tables.

Also Note: Your screen name cannot contain any symbols in it. This poker
network allows symbols in screen names such as $ and ?, but our bot will not
work properly if your screen name contains characters other than letters and
numbers (upper or lower case letters is fine). In addition, your screen name
cannot contain the word ‘holdem’ in it.

The bot will resize the table to how it needs it as soon as it is attached. This is to
make multi-tabling easier, as the default table size fills the entire screen. We find
it easiest to resize the table to the minimum manually, before starting the bot,
especially when multi-tabling. This way, you can move the table location first.

There are three crucial option settings for the poker table that must be set in
order for the bot to read everything.

1. The poker table chat must be set to display on the table in the lower left
window, not ‘info’ or ‘stats’. It cannot be detached to the side-dock either.
Also, never click on the poker chat scroll bar on the side of the chat. The
table should look like this, with the chat bubble highlighted in blue:




2. From any poker table, bring up the options window by clicking on the gear
icon on the top left. In this window, on the General Tab, under Chat
Options, make sure Show dealer chat is checked:

General ]Themes l Sounds I Buy In/Top Up I

~Chat Options
[ Show players chat
[V Show dealer chat
I~ Show observer chat
[V Winning hands summary

~Game Options
[V Show Promotions
[V Show Animations
IV Auto switch between tables

|

- Display Hand Hint -
[V PlayMoney Tables
[V RealMoney Tables
IV Toumaments

—Other options
[V Show The Beast Points




3. Then, from the Themes tab, make sure the 2-color deck is checked:

General Themes ISoundsI Buy In/Top Up

i~ Table Background
o -

Card Settings -
{* 2 color deck " 4 color deck

A K

o PV 20 N i&? 190
o BT

No other settings matter. Don’t forget to always start the poker room software to
run as administrator. You can set it so it always starts that way; for instructions
see: http://bonusbots.com/support/index.php/topic,6734.0.html

Rakeback: Some of the poker rooms on this network offer a 27% rakeback deal
which you can get by following this link: http://tinyurl.com/I6x9cph



http://bonusbots.com/support/index.php/topic,6734.0.html
http://tinyurl.com/l6x9cph

Chico Poker Network
(BetOnline, Sportsbetting.ag)

Note: BetOnline cash tables have an annoying blackjack table attached on the
right-hand side and there doesn’t appear to be any way to get rid of it. No big
deal, as it doesn’t bother our bot.

The bot will resize the unhooked table to where it needs it as soon as it is started.
This is to make multi-tabling easier, as the default table size fills the entire screen
on most monitors. Don’t worry -- the bot can still see everything even if you can't.
When multi-tabling the tables can overlap if necessary, but it's probably wise to
stagger them a little so the betting buttons don’t overlap.

From the poker room lobby, click on Options and set as follows:

Options
Language > English
Table Background > Stadium
Animations > On
4-color deck — Do not check!
Tile Windows — Do not check!

Lobby Cashier History My Bonuses | Options | Help
Languages » . 7

7 tachum : K\ ‘

| Table Background | © y
BETUNLIN, - SIS 110 1 BEONLNE
Anmimations » g

4-Colour Deck CTRL-O
OMAHA  TOURNA} . windows CTRL-T
ALL STAKES Import Player Notes...

TABLE NAME STAKES LiMIT SEATS | PLRS v | WAIT AVG POT FLOP %

Dumh and Dumber $0.01/0.02 ML 10 10 1 $0.58 43% oy B Z 0 ll

Transcendence $001002 N 10 10 1 $0.57 32% 100% SLOTS MATCH BONUS
24 5001002 N 10 10 1 $0.67 39%

James Bond $001002 N 10 10 3 $1.91 44%

Ertourage 001002 ML 10 10 1 $0.51 42%

Paycheck $002004 N 10 10 3 $1.03 49%

Clash of Empires $002004 ML 10 10 2 $1.05 52%

Atnie $003006 ML 10 10 0 $1.53 45%

Chuck Noris $003006 ML 10 10 0 $1.54 7%

The Rover $0.05010  NL 10 10 1 $2.49 28%

The Giver 5005010 ML 10 10 1 $2.43 29% P l Av " I]w
Tammy $005010 N 10 10 1 $2.35 25%

No Limit Pat Limit Fixed Limit Head's Up Fu Empty |

No other settings matter. Don’t forget to always start the poker room software to
run as administrator. You can set it so it always starts that way; for instructions
see: http://bonusbots.com/support/index.php/topic,6734.0.html



http://bonusbots.com/support/index.php/topic,6734.0.html

Full Flush Poker
(Equity Network)

Note: Full Flush uses the same poker room software platform as the Chico
network above (Betonline & Sportsbetting.ag) but operates on a different network
so has different games and players.

The bot will resize the unhooked table to where it needs it as soon as it is started.
This is to make multi-tabling easier, as the default table size fills the entire screen
on most monitors. Don’t worry -- the bot can still see everything even if you can't.
When multi-tabling the tables can overlap if necessary, but it's probably wise to
stagger them a little so the betting buttons don’t overlap.

From the poker room lobby, click on Options and set as follows:

Options
Language > English
Animations > On
4-color deck — Do not check!
Tile Windows — Do not check!

Lobby Cashier My Bonuses [Options] Help

Languages 4'@‘:
CASINO LIVE CASINO

Change Table Background...

3 MONTHLY POP
Sound a ACCUMULATOR m
Animations '@ On # Running Il Completed Il

4-Colour Deck CTRL-O Off
Tile Windows CTRL-T Active Table J0 BIG NIGHTLY FREEROLL

; > I Import Player Notes...
lin 51 minutes  $2,000 GTD BACKZBACK 2 q  $2.0U+pU.00 - 4 T F1$300 BIG NIGHTLY
3001 27 19:02 $25 FREEROLL ON DEMAND 1 POP
{Oct 31 11:02  $1,000 Dep/Reload FREEROLL -
io:t 27 18:22 $5000 HIGHROLLER SPECIAL Reg $50+85 Gold
%om 2718:22 $2,000 LATE NIGHT 3 Reg  $5.50+$0.55
Oc‘t 27 19:02 $500 GTD $2 Special Reg $2+$0.20
{Oct 31 14:02  $5K HALLOWEEN BOUNTY TREA Reg $15+81 .50
;001 27 20002 $1500 GTD AFTER HOURS Turho Annc  $4.50+30.45
|Oct 27 21:02  $200 GTD Turbo RebuyiAdd Annc  §$1.60+50.16
:'Oc:t 27 21:02 $25 FREEROLL ON DEMAND Annc 1 POP
|Oct 27 23:02  $25 FREEROLL ON DEMAND Annc 1 POP

Deposit Freeroll Tick

Tournament Lobby

LOADS GET 100% up to $1500 PLUS up to 30% CASHBACK... TOURNAMENT PLAYERS CHECK OUT THE NEV

No other settings matter. Don’t forget to always start the poker room software to
run as administrator. You can set it so it always starts that way; for instructions
see: http://bonusbots.com/support/index.php/topic,6734.0.html



http://bonusbots.com/support/index.php/topic,6734.0.html

Bodog / Bovada Poker (Including Chinese Bodog room)

Note: Our bot uses “OCR technology” to play at Bodog and Bovada, which is
different than the technology used for supporting our other poker rooms. This
means that the bot is dependent upon reading information from the screen and
therefore will be more sensitive to monitor and display settings. Tables can still
overlap when multi-tabling, because the bot brings the active table to the front
and takes a screenshot when it is your turn to act.

However, when playing more than three tables you might see timing issues when
you have to act at more than one table at the same time, as the multiple tables
waiting for your action fight each other for the front view. In these cases the bot
may take longer than the normal 2 seconds to act, and in rare instances may
even time out without acting. This looks quite natural however, as human players
often have the same issue under these circumstances. Also, this issue will be
dependent somewhat on your system resources. Most people can play at least
three tables without noticable timing issues.

Lobby settings: You must set the Game Play Settings tab exactly as shown
below, at both Bodog and Bovada, under the Preferences options in the lobby.

Preferences

(Pres to close)

About This Software

Tahle Settings

Game Play Settings Default Buy-in

Game Play Settings

Show Pot Total
Display the Pot Total for each hand above the main pat.

Show Bet Value

View your opponents numeric Bet Values along with their
chips for each round of betting.

M Show Hand Strength

Display your best S-card hand to the right of your pocket
cards,

E Show Table Spotlight

Turn on the Spaotlight to follow the action at the Paker table.

E Show Game Play Animation
Turn on Game Play animation such as chip and card
moverments,

M Rabbit Card

Displays the next card that would have been dealt after the
hand has ended,

Language

English |v|

M Folded Hand Display
Show your folded pocket cards until the end of each hand.
Cpponents will not see them.

M Use Four Colored Deck
Use a 4 colored deck. Clubs will be shown as green and

diamonds will be blue.

M Disable Enter to Bet
Prevents the keyvboard Enter key from placing a bet.

M Disable Pop to Front
Prevents the table from popping in front of other windows

when it is your turn,

B Auto Muck Hands

Always muck losing/uncalled hands.

M Enable Fold and Show

Enable the ability to fold and show your hand at the
showdown,




In addition, on the Table Settings tab the background must be set to red.
These Preferences settings from the lobby are not optional and must be set
properly in order for the bot to function at Bodog/Bovada.

Make certain that you do not collapse the box on the table screen which shows
the options for auto-posting blinds and sitting out! If you do, the bot will not be
able to use the sit-out functions such as the bathroom break settings. That box
looks like this:

b -
@ Auto-post blindfante

@ sSit out next hand

See that little arrow above those check boxes on the right? Stay away from that!
If you click it, that entire box collapses and hides the sit-out options. If they are
not visible on the screen, the bot cannot check them and follow sit-out
commands.

Do not enable “preferred seating” on the Table Settings tab! It doesn’t matter
which seat the bot is in, but the preferred seating function may hinder the bot’s
reading ability in some situations.

Troubleshooting: If you have correctly followed the above setup instructions
and the bot cannot read the cards (and therefore will not act), then it is highly
likely that a windows variable has been installed on your PC registry from
another downloaded software program, which is interfering with the bot’s ability
to work properly at Bodog/Bovada. In this case, the bot should return a warning
message about the presence of this file, which is unnecessary and safe to
remove. You can find instructions for removing it, plus a link to a free app which
will remove it for you, here:

http://bonusbots.com/support/index.php?topic=5318.0

Non-standard systems may have trouble trying to run the bot at Bodog/Bovada,
due to the nuances of using OCR technology (for example, a laptop + external
monitor or a Netbook PC). You might play around with the resolution and display
settings in these cases.

English language must be used.


http://bonusbots.com/support/index.php?topic=5318.0

888 Poker & WSOP Poker

(Includes Spain 888.es room, Chinese version, 888 New Jersey, WSOP Nevada,
WSOP New Jersey, WSOP U.K.)

Important: The older version 24 of the poker room software is required for
our bot to work on the 888 rooms. Most of you should be able to downgrade to
that version via this link:

setupspoker.images4us.com/setups/888poker/EN/p-1-en-4-6.17-
0/24/SetupFiles/GIB/FULL/888pokersetup.exe

Please Note: For the first hand dealt in any game at this poker room, the bot’s
stack size, position, and opponent count will be unknown and/or incorrect for the
first hand only, but should correct from the 2nd hand onwards.

You must set the following display options on the poker client from the 888 poker
lobby including the preferred seat positions. These are all critical and are not
optional in order for the bot to function properly.

Set the Game Settings tab as follows:

Table layout Personal image Garmne settings Game display Yideo § Audio

M Open lobby once a table is closed

ECE -
ixee |

Language: 3
M Show casino games button Default minimum bet:

M Hide bankroll balance
HE BEHEE = ™ Keep my hand histary in:

selsasih.vrampataoangacfiern i
P —

M Disable shortcut keys

™ Show folded cards

O Upon sliding the mouse over the name plate
® 25 faded cards until the end of the round

Tirne bank activation
O Autornatic
® Manual

when it's my turn to play:
™ Pop up the game window
™ Flash the task bar

When table screen is chosen, set focus on
® Chat
O Betting box

Days to keep hand history: 30 |

Tournament auto Rebuy/Add-on options
MW 2uto Rebuy

M 2uto Double Rebuy

M Rebuy Whenever Possible

M Auto Add-on



http://setupspoker.images4us.com/setups/888poker/EN/p-1-en-4-6.17-0/24/SetupFiles/GIB/FULL/888pokersetup.exe
http://setupspoker.images4us.com/setups/888poker/EN/p-1-en-4-6.17-0/24/SetupFiles/GIB/FULL/888pokersetup.exe

Set the Game Display tab as follows:

Table layout Personal image Game settings Game display Video § Audio

M Hide chat callouts Preferred seat:
M Show best hand
& Show final table in special background

M Progress bar settings

o Show bonus bar by default, and status bar when there
are no bonuses

® Show status bar at all times
™ Play sound effects
O al
® notifications only
 Enable animation
M Enable extra visual and animations features

Snap animation
O Revolve
® Fade
® [No animation

Table layout Personal image Game settings Gamne display Video f Audio

M Hide chat callouts Preferred seat: [6Seats |k
™ Show best hand

™ Show final table in special background

™ Progress bar settings
o Show bonus bar by default, and status bar when there
are no bonuses
® Show status bar at all times
™ Play sound effects
O &l
® notifications only
 Enable animation
M Enable extra wisual and animations features
Shap animation
O Revolve
® Fade
® Mo animation




You must have the English language selected on the Game Settings tab for the
bot to work here (this includes the Spanish and Chinese rooms), and you must
have your windows language set to English/US.

You must select the preferred seat for each table type on the drop-down list as
shown above! For all table types except 6 and 8 player tables, it is the bottom
center seat. For 6 and 8 player tables, it is the right-bottom seat. In other words,
if a bottom center seat exists you must be seated in it! If not, you must be
seated in the bottom right seat!

Finally, set the Table Layout tab as follows:

ﬁTSCf ting

Table layout Personal image Game settings Gamne display Video § Audio

Choose your table theme

Choose your deck | o ‘ ) fr
Wr"'

Choose your cards' face [ K K — K
¢ ¢\ T
. ek ICK

™ Enable action colour on name plate M Save layout
M Do not show personal images on table ™ Use Snap theme

M Full card view

Make sure that on the Video/Audio tab you did not check the box that says
Show final table in special background, or the bot will not be able to play the final
table in MTT’s!

Please remember that 888 Poker must be run as administrator on all operating
systems except XP. You can set any program to always run as administrator
when opened; for instructions go here:

http://bonusbots.com/support/index.php/topic,6734.0.html



http://bonusbots.com/support/index.php/topic,6734.0.html

iPoker Network

(William Hill / Ladbrokes / Betfair / Titan / TitanBet / NetBet / Bet365 / Boyle /
Winner / Paddy Power / Everest / Sisal.it / Titanbet.it / Turbopoker.fr / Everest.fr)

This setup is for all supported iPoker network rooms, including the French and
Italian only rooms. These settings adjustments are all critical and must be
followed in order for the bot to function properly.

Please note that France residents need to use the English version of the poker
clients at all three supported France rooms (including EverestPoker.fr). However,
Italy residents must use the Italian version of the poker clients at both supported
Italy rooms.

Poker Client Setup

Go to Options > Settings and on the Chat tab check all the options, as follows:

Settings

Lobby Show Dealer Chat
Show Player Chat
Show Observer Chat
Show Summary
Show Card Images
Chat Show Player Actions

Table

Avatar

Cards

System Chat - view bubbles

Audio

Casino games
BackBet game
Table Timeout

Multi Tables

Cancel

=

(Note: The player chat and observer chat can be unchecked if desired, and may
improve bot performance, especially when multi-tabling.)



Next, go to the Multi Tables tab and set the options as follows:

a

Settings

Lobby Take Focus from applications

Table Take focus from other table

B set focus on bet amount
Avatar .

B Keep focus on Chat and Motes
Cards
Ch
System

Audio

Casino games

Table Timeout

Multi Tables

Settings

Lobby General

Yiew Hand Strength
Show Folded Cards
Show All-in Odds
B Enable Spotlight

Audio Remember table positioning

Casino games Actions

BackBet game B Display Warning for Large Bets

Table Timeout Auto muck

g Auto Top-up (<
YILICH T ables
Configure betting buttons

0K




Important: If a Configure betting buttons link is available near the bottom of
the Table tab, as above (some iPoker rooms have it, some don’t), you must click
that and then configure your betting buttons as follows:

I

Configure betting buttons

3
Post-Flop

Buttons 1 50
Buttons 2 |20 - 100 |

Buttons 3 Max > Max v

Cancel

L® =

If you do not configure Buttons 2 and Buttons 3 as shown above (for the iPoker
rooms which have user-configurable betting buttons), there will be no Bet Pot or

Bet Max buttons available on your screen, resulting in the bot’s inability to follow

these commands.

Also Important: If a Widgets tab is available, the Show Widget Bar setting
must be un-checked at every iPoker room (except for Titan):

Settings

Show BackBet game
B show Widget Bar

Lobby
Table
é’ﬁwahar
Chat
System

Audio

Widgets
Multi Tables

Cards

m———
0K Cancel




At Titan Poker (including TitanBet.it) The Show Widget Bar setting above must
be checked!

None of the other settings on any of the other tabs are important for the bot, so
they can be set as you desire.

Windows Settings

Both the bot and poker client must be run as administrator for Vista and Windows
Seven machines (see section 1.1). The bot automatically runs as administrator
on Windows Seven systems, but the poker client still must be opened that way
every time. On Vista systems, both the bot and the poker room software must
always be opened to run as administrator, using the right-click mouse option.

Your Windows language/regional settings must be set to English/U.S for all

poker rooms (see section 1.2) with the exception of the Italian and French-only
iPoker sites that are supported.

Poker Table Chat Window: Important!

There are two sizes that the poker table chat window can be and the bot needs it
on the larger of the two sizes in order to read the dealer messages (please note
that it can still read them even if the tables overlap and the table is covered by
another table, however). This is very subtle and easy to miss, so please do play
around with the poker table chat size to the point where you understand how to
expand and collapse it. This does not apply to Speed Poker tables, however,
which use a different type of chat window that is not resizable — but the poker
client will collapse all poker chat windows after playing on a Speed table,
requiring you to expand them again the next time you play a non-speed table,
including any tournament!

Speed Poker

The bot supports Speed Poker tables at all our supported iPoker rooms. They
can be multi-tabled in the usual manner. However, please note that after playing
on a Speed Poker table, the poker table chat window will then be collapsed at all
non-speed tables (including tournaments) and will have to be expanded again
manually before the bot will work at them again.

Also, the bot will speed-fold the weaker starting hands automatically, which
means it will not attempt to steal blinds with them in late position, being as it does
not evaluate position until it is the bot’s turn to act. Speed-folding can be disabled
on the bot’s option menu under Options > Other Options > Disable Speed
Folding if you wish to steal blinds instead. It will slow the pace of the game some,



but not too much since most of the speed comes from not seeing the flop and
having to wait for opponents to play out a hand.

Tournaments

At the iPoker rooms, the bot will ask you for your screen name when you play a
tournament. Be careful of typos! If the name you enter does not match your
screen name at the table exactly, the bot will not be able to read your stack size!

Sisal.it and Titanbet.it

The bot also supports the Italian iPoker rooms Sisal.it and Titanbet.it, for Italy
residents only. These are the only Italian iPoker room currently supported, and
the bot works with the Italian language only here. The same other iPoker setup
instructions apply.

TurboPoker.fr, EverestPoker.fr, and Unibet.fr

The bot also supports these three French poker rooms, for France residents only.
You must use the English speaking poker clients, as the bot only reads English
at these three sites. All other iPoker setup instructions apply.

Rakeback

Private (non-advertised) rakeback deals are available for certain iPoker rooms
and they are juicy! Check our support forum for the latest offers.

iPoker Troubleshooting

Problems reported using the bot at any of the iPoker network rooms almost
always end up being due to one of these five things:

1. Not having your Windows language set to English / US (English / UK is no
good because the betting amounts need to have decimals, not commas).

2. Not using an English speaking version of the poker client.

3. Having collapsed the poker table chat window. This is the most common
error. There are two sizes that the poker table chat window can be and the bot
needs it on the larger of the two sizes in order to read the dealer messages in the
poker table chat (please note that it can still read them even if the tables overlap
and the table is covered by another table however). It is quite easy to accidently



collapse the chat on the poker table. If you have done this, some arrows will
show on the right side of the chat that you can click and expand it back again.

4. Not having configured the betting buttons in the poker client properly,

resulting in no 'pot’ or 'max’ size betting buttons available on the screen for the
bot to use. See above screenshot of how they should be configured (if you are
playing at an iPoker room which has incorporated that feature in the software).

5. Failing to start the poker room software to run as administrator. This must be
done every time it is started. You can set it so it always starts that way; for
instructions go here:

http://bonusbots.com/support/index.php/topic,6734.0.html

6. Having the widgets setting enabled if you are not playing at Titan, or having it
disabled if you are playing at Titan.

7. A typo in entering your screen name on the bot for tournaments, resulting in
the bot being unable to read your stack size. The screen name you enter must
match your name displayed at the table exactly.

8. Having checked the “set focus on bet amount” box on the multi-tables tab.
Don’t do that!


http://bonusbots.com/support/index.php/topic,6734.0.html

1.4 Additional Stealth

While the Holdem Bot comes includes a built-in Hiding feature, there are some
additional steps you can take to hide it on your system even further. We want to
stress, however, that we think this is unnecessary. None of our supported poker
rooms are giving any of us any trouble. Your best defense is to simply not play
inhuman-looking marathon sessions.

Moving and renaming the bot folders.

A) Create a new folder on your PC somewhere, on your C: drive should be
fine, and name it something creative like “spykiller.”

B) Rename the two folders that installed on your C: drive when you
downloaded the bot. (Remember, on your C: drive there is a folder titled
Poker and within that a folder titled Data, rename both of those to
something that has nothing to do with poker).

C) Move the outer of the two bot folders that you renamed in Step B above
into the new folder that you created in step A above.

Example: New folder was named spykiller, Poker folder was renamed install,
Data folder was renamed records. So the path to your bot folder is now
C:\spykiller\install\records. You will need to navigate there to access the bot
and also when downloading bot upgrades.

D) Move your license file into the bot folder with the bot (if you had it on your
C: drive or on your desktop)

E) Remove any desktop shortcuts to anything bot-related. No desktop
shortcut to the bot or even the bot folder! You will need to “dig” for the bot
when you want it.

F) Rename the bot itself (holdembot.exe) to something like
MSOUTLOOK .exe or skype.exe. Do not rename anything else in the bot
folder!



1.5 Sitting in a Game and Starting the Bot

Your poker bot came with 5 files in the download bundle. Two of them were
instructional PDF files (this manual being one of them). The other three must all
be kept in the same folder/directory or the bot will not work. They are:

* holdembot.exe — this is the bot software (the .exe extension may not show)
« .dll file — this is a necessary gears file and the exact name is changed often
* holdem.ppl — this is the default profile (the .ppl extension may not show)

To open the bot just double-click on the generic-looking program icon titled
holdembot. On Vista you must run the bot as administrator. To do this right click
on the above icon and choose “Run As Administrator” from the pop up menu.
The default profile loads automatically from the holdem.ppl file, and you should
get that confirmation message in the bot window when you first start it. We would
suggest playing in the 9-max or 6-max No Limit cash games for your 200-hand
demo, since the default profile was designed for them. Take a seat at a table in
either a play money or real money game. Any open seat is fine as long as you
followed the instructions in section 1.2 above for your chosen poker room.

» Do not tweak the poker room settings so that you are moved from the default
bottom center seat position that the poker room places you in, at those rooms
that default place you there. The bot can only function properly when you are
seated there (you should be moved there no matter which open seat you
choose).

» Click on auto-post blinds at the poker table. You might want to wait for the big
blind before starting, but if you want to come in with a late position blind that is
fine.

» Open the bot if you have not already done so. Wait until you are clearly
between hands before starting the bot or before opening a new bot window.

» Start the bot by clicking Start on the bot program menu. You should then notice
it reading the board cards as they are dealt. When it is your turn to act the bot will
read your cards, its position, the number of opponents, and the entire situation
and play the hand for you in a manner consistent with expert-level poker play.

» Optional: Hide the bot window by clicking on Hide on the bot program menu.
Before it vanishes from sight it will give you the keyboard command for bringing it
back (usually Alt+F10 ).



1.6 Multi-Tabling

To open additional tables for the bot to play, first take a seat at the new table and
click auto-post blinds. Then go to Holdem > New Window and click New Window.
A new bot window will appear. The second poker table should be in front, if
possible, when you click start on the new bot window.

Only one unhooked table can be open when you start the bot. It will
automatically attach itself to whatever table is open that has no other bot window
connected to it. There cannot be two poker tables open that do not have bot
windows attached to them, or it won’t know which one to hook to. For this reason,
you must open the tables, join them, and hook a bot window to them (by pressing
start on a bot window) one at a time. Multiple bot windows can be opened in
advance, however.

The Hide button hides all the bot windows at once. So, when multi-tabling,
minimize the bot windows that are already attached first, and when you have
started as many tables as you want, then hide all the bot windows at once.

Table Positioning Tip: If you have a big screen you should try and position the
tables so there is minimum overlap between them. On smaller screens, you
should at least position the tables such that the button areas do not overlap.
Position the 2" table window such that it is a little (about two inches) to the right
of and a little (about 2 inches) below the 1% table and so on. However, tables do
not need to be visible for the bot to work and they can all overlap if necessary.

If the bot cannot connect to the additional table on its own, it will ask you for the
name of the new table. Be sure to spell it correctly and make sure you capitalize
the right letters. Try to do this as quickly as possible.

Repeat the process for opening a third and fourth table if desired, to a maximum
of 6 tables (any exceptions to 6-tabling ability are mentioned in the poker room
settings adjustments sections).

To stop: First quit the poker game in the normal manner and close the poker
room software. Then bring back all bot windows with the appropriate Alt+F
commands and close them.



Shanky _
Technologies

Profiles

2.1 Using Different Profiles

Many alternative profiles targeting different game environments already exist for
our Holdem Bot. We encourage you to check them out in our support forum.

In addition, you can easily make the bot play any way you want for any poker
situation. There is a short learning curve for doing this, but it is not difficult.

The bot gets it’s playing instructions from one of four “levels,” the top overriding
level which you can alter and customize to your heart’s content. User instructions
for specific situations can be created and saved on a standard text file by using
Notepad, the text editor that comes with Windows. These saved playing
instructions are referred to as profiles. You don’t need any computer
programming knowledge in order to make your own profile, or to tweak an
existing profile to your liking. Just knowing basic poker terms is enough for most
people to be able to do this.

There are two types of profile formats: .ppl (a type of binary file) and plain .txt
(text files). A .ppl file started out as a .txt profile but was converted to the other
format to protect the profile from being copied. You cannot open a .ppl file for
viewing; only our software can access it. You can create and save profiles in .txt
format, but you cannot convert them into .ppl unless you have us do it for you, or
purchase the .ppl converter from us. (You don’t need to do this unless you plan
on selling or sharing your profile and want to copyright-protect it.)

The default profile that came with the bot is in .ppl format (and has been named
holdem.ppl so it auto-loads, as will be explained below). The only other way you
are likely to get that type of profile is if you decide to purchase one from a
reputable seller in the Marketplace section of our support forum. Most of the free
profiles in our forum, many of which are quite good, are text files that can be
opened, viewed, and tweaked to your liking.

At any given time exactly one .ppl profile and one .txt profile can be loaded
into the bot. No more. Either can be swapped out at will. Commands from a .txt



profile will always be executed first, as that type of profile loads at the top level
and is read by the bot first. The first matching command is always executed. So
.txt profile actions override any conflicting .ppl profile actions. This way it is
easy for you to tweak a play here and there and save it as a short text profile.

Both types of profiles can be set to auto-load by default whenever you open a bot
window. That is what the default profile that comes with the bot is set to do. To
designate a profile as a default auto-load profile, all you have to do is rename it
as follows:

.ppl file auto-load name: holdem.ppl
txt file auto-load name: AutoProfileHoldem.txt

Any profile kept in the same folder as the bot that has the above name will auto-
load into the bot by default whenever you open a bot window. So obviously you
cannot have more than one of each file type with the above names, or it will
create a conflict. If you have one of each profile types saved with the above
names they will both auto-load. But remember, the .txt file takes precedence.

For the demo we recommend you stick with the default profile and play cash
games. You might want to try playing with one of the alternative profiles in our
forum for a bit, or, if you are really adventurous during your 200 free hands, you
might decide to read a little of the PPL Guide and try tweaking an action or two to
get the feel of how customizing the bot’s actions works.

2.2 Creating (or Tweaking) Your Own Profile

In order to customize the bot’s playing instructions, you first need to understand
how the existing programming works. There are four levels in the bot where
playing instructions come from, and each higher level overrides the next lower
level. They are:

Root-level programming

Option Settings on the Bot Menu
Any .ppl profile that is loaded
Any .txt profile that is loaded

PwpnpPR

The root level programming lies at the core. This is the original bot that we
started selling in 2006, before it was improved 100 times, and before it became
user-configurable. It actually plays decent poker to this day, and many actions in
the current default profile are still referred to it.



The option settings on the bot’s main menu are the second level. These were
originally developed to start allowing user control of the bot’s actions. They are
explained individually further in this manual. The thing to understand about these
is that adjusting the option settings on the bot will only affect actions that are
referred to the original root level programming. If you want to create a profile just
from the bot’s option menu settings, you can still do that. But you will need to
disable all other profiles from loading (because written instructions in them will
override the option settings, so you will need to rename or remove the default
holdem.ppl profile that is set to auto-load in the bot folder). This is still a viable
way to make your own profile, however, especially for tournaments.

Profiles that consist solely of option menu settings can be manually saved as a
text profile directly from the bot, and loaded again by using the menu items:

Holdem > Write Profile
Holdem > Read Profile

Write Profile is used to save them and Read Profile is used to load them. Profiles
are saved as a simple text file, and then can be edited in Notepad. You can also
add your own custom instructions to a profile that you saved from the bot by
writing them in PPL underneath the saved option settings. PPL is the easy Poker
Programming Language any poker player can learn in about an hour with no
coding background needed (see the beginning sections of the PPL Guide that
came with the bot download).

The default path for saving and loading the profiles into the bot is the same folder
where the rest of your bot program files are located, which should be at
C:Poker\data if you did not move it. So, the default location of the folder with your
bot files was installed on your C: drive in a folder titted Poker and in a subfolder
titled data.

Profiles in .ppl format are the third level that the bot gets it’s instructions from.
Remember, these are just a saved text profile that has been converted into this
format. You don’t need to be concerned about this (other than the fact that the
default profile which comes with the bot is in this format) unless you are
downloading profiles in this format from our support forum.

Profiles in .txt format are the fourth level. Instructions from text profiles override
everything. That way you can load a text profile with just a few lines of PPL code
which will tweak a few actions here and there from the .ppl profile that you have
loaded. Tweaking actions from the default profile in this manner is a great way to
start making your own profile!

Within a saved profile there can be both saved option settings and PPL coding.
The PPL coding starts with the word “custom.” Some text profiles in our forum do



not bother with the bot’s option settings. These will always start with the word
custom on one line at the top of the profile. Profiles with saved option settings, by
contrast, will have those settings saved above the word custom, like this:

File Edit View Settings ?

DE A | raalas@ o i
27 FoldorGoAllInwhenopponentsAfterFoldsLessThanstacksize

= 1000000
28 ApplyFoldorallInafter = 0
29 FoldorGoAllInwhenOpponentsAtTableLessThan = 5
40 FoldorGoAllInwhenOopponentsAtTableLessThanstacksize
1000000

41 AlwayscallwhenopponentsRaiseIsLessThan = 4
42 AlwayscallwhenstacksizeIsLessThanTotalInvested = 90
43 Verbose = ON
44 AutoPlay = ON
45 UserDefinedGameType = 0
46 UseOCrAtFullTilt = OFF & Saved Option
47 AutoRebuyAtUB = ON Settings are
48 AlwaysAskForTableName = OFF
43 pefaultBetSizeFlop = 100 Ebove th"e word
so befaultBetsizeTurn = 75 custom
51 DefaultBetsizeRiver = 60
52
53 custom >
54 //MTT Kit + Doodle 106 PPL COdlng starts

55 preflop here
56

57 when bigblindsize >= 1000 and (raises = 1 or
botslastaction = raise) and stacksize < 30 and (hand =
QQ or hand = J31) raisemax force

58

59 when stacksize > 100 and raises >= 1 and betsize > 12
and not (hand = AA or hand = KK or hand = QQ or hand =
AK or opponentisallin or opponentsattable <= 3) fold
force

60

Ln1:1450 Coll Sel0 160 KB ANSI CR+LF INS DefaultTe:

PPL coding always overrides the saved options settings. So PPL code in a text
profile is always at the top level and that is the best way to start tweaking your
own profile. This can be very simple, something like:

preflop
when (hand = AA or hand = KK) and raises >= 1 raisemax force



...which tells your bot to raise all-in with pocket aces or pocket kings whenever
somebody else raises. All of PPL language is simple and intuitive like this, so do
give the PPL Guide a read to start learning how to customize your own actions.

The default profile that comes in the bot is called the “Doodle” profile, and is
available as a text profile as well. It is designed for full 9 or 10 player cash
games. If you would like the text profile version of it, the latest version can always
be accessed at:

www.bonusbots.com/doodle.txt

There is also an MTT version of the Doodle, which has been altered for optimal
tournament play. It can be accessed here:

www.bonusbots.com/mtt.txt

You will need to copy the code and save it into a new text file (just open Notepad,
usually located in the Accessories folder on the Windows Start menu, paste it in,
and save it as shown in the screenshots below).

As you can see, some profiles are simply tweaks of other profiles, while others
are complete and self-contained. It is difficult to define every possible poker
situation (it took us two years to do that). Therefore most profiles, even fairly
detailed ones, still use the original root level programming as a safety net. Many
simply tweak the default Doodle profile.

To summarize, there are three practical methods of customizing profiles for use
in different game types.

1. Make changes to the quick-settings located on the Option Menu of the bot.
Many excellent profiles have been created with this method, and in fact one of
the best tournament profiles being used by our forum members is of this type and
contains no PPL- coding whatsoever. It has made plenty of high-money finishes
in large-field MTT’s including some firsts, completely unassisted. Just remember
that option settings do not override PPL commands. So if you are making these
option setting adjustments when you have a profile loaded that uses PPL code,
the settings may not take effect in every situation you want them to.

2. Add some custom code to your saved profile by learning PPL, the easy Poker
Programming Language that puts you in total control. All of the bot’s actions can
be 100% user-configured in this manner, and it’s easy to use. If you are tweaking
a profile that uses PPL, this is the only reliable way to get your desired actions to
always occur. See the PPL Guide that was included with your download (and is
therefore located in the same folder as the bot at C: Poker / Data) for more
information.


http://www.bonusbots.com/doodle.txt
http://www.bonusbots.com/mtt.txt

3. Simply use an existing profile that somebody else created. There are several
good ones posted on our website, and new ones are being built and shared in

our support forum every day.

2.3 Changing Profiles in the Bot

Profiles can be loaded into the bot either automatically, semi-automatically, or
manually. But before you can load a profile, you first must save it and place it in
the bot directory. This can be a tad tricky if you have never worked with a text
editor like Notepad before, so let's make sure you are saving the profile properly.

Notepad vs. Enhanced Text Editors

If you plan on tweaking your own profile using PPL, we highly recommend
downloading Notepad 2, an enhanced text editor greatly superior to the original
Notepad program that comes in windows. This is an open-source (free) program,

So just Google it.

One of the nice things about Notepad 2 is it displays the codelines on the left
side, so you don’t have to search for them (also, original Notepad will sometimes
mis-reference codelines). You can see the difference here:

Bt Notepad
File Edit Format View Help
// 6-pack version 11 updated 11/23/2014

custom
preflop

// The following three lines are user-variables for the
poodle profile, in case you are using the Doodle as the
back-up. If not, no harm done in simply setting them true
when raises = 1 and lastraiserposition >= 6
userearlyRaiser

|when raises = 0 and calls >= 1 and firstcallerposition >= | |

|7 and stilltoact >= 3 uUserTrapl
when opponentisallin userbead

when (hand = AA or hand = KK) and raises = 0 and calls = 0
and stilltoact >= 4 and random <= 33 raise force

when raises = 0 and calls = 0 and stilltoact <= 3 and
(pairinhand or hand = A or hand = KQ or hand = KJ suited
or hand = K9 suited or hand = K8 suited or hand = K7
suited or hand = QJ suited or hand = Q9 suited or hand =
Q8 suited or hand = JT or hand = 19 or hand = 38 suited or
hand = 37 suited or hand = T9 or hand = T8 suited or hand
= T7 suited or hand = 98 or hand = 97 suited or

suited or hand = 87 or hand = 86 suited or hand

suited or hand 76 or hand = 75 suited or hand

suited or hand 65 or hand = 64 suited or hand

suited) raise 2 force

when raises = 0 and calls = 0 and stilltoact <= 2
(hand = 86 or hand = 97 or hand = T8 or hand = 77 or hand
= 18) raise 2 force

when raises = 0 and calls = 1 and (hand = AA or hand = KK
or hand = Q@ or hand = 33 or hand = TT or hand = 99 or
hand = AK or hand = AQ suited or hand = AJ suited or hand
= KQ suited) raise 3 force

when raises = 0 and calls = 1 and stilltoact <= 3 and
(hand = 88 or hand = 77 or hand = 66 or hand = 55 or hand
= AQ or hand = AJ or hand = AT or hand = A suited or hand
= KQ or hand = K9 suited or hand = JT or hand = J9 suited
or hand = 318 suited or hand = T9 or hand = T8 suited or

DERE| walakEexau
1 // 6-Pack version 11 updated 11/23/2014
3 custom
4 preflop
5
6 // The following three lines are user-variables
for the Doodle profile, in case you are using the
pDoodle as the back-up. If not, no harm done in
simply setting them true
7 when raises = 1 and lastraiserposition >= 6
uUserearlyRaiser
s when raises = 0 and calls >= 1 and
firstcallerposition >= 7 and stilltoact >= 3
UserTrapl
9 when opponentisallin uUserbDead
10
11 when (hand = AA or hand = KK) and raises = 0 and
calls = 0 and stilltoact >= 4 and random <= 33
raise force
12
13 when raises = 0 and calls = 0 and stilltoact <= 3
and (pairinhand or hand = A or hand = KQ or hand =
K] suited or hand = K9 suited or hand = K8 suited
or hand = K7 suited or hand = QJ suited or hand =
Q9 suited or hand = Q8 suited or hand = 1T or hand
= 39 or hand = 38 suited or hand = 17 suited or
hand = T9 or hand = T8 suited or hand = T7 suited
or hand = 98 or hand = 97 suited or hand = 96
suited or hand = 87 or hand = 86 suited or hand =
85 suited or hand = 76 or hand = 75 suited or hand
= 74 suited or hand = 65 or hand = 64 suited or -

[Ln1:87 Coll Sel0 6.59 KB ANSI

CR+LF INS Defau




Notepad 2 is on the right above. It has many advanced features, and displays the
codelines in red on the left side.

There is a critical difference between these two programs, which you need to be
aware of, when it comes to saving profiles. Original Notepad will automatically
assign an invisible .txt extension to the file type when saving a text profile. This
means you must not add a .txt extension to the file name when saving it from
Notepad! If you do, the bot will not find it when you try to load it because it will
actually have two .txt extensions, though only one is visible. (If you’'ve done this,
you can fix it by right-clicking the file, choosing Rename, and then both .txt
extensions will appear — simply remove one of them).

So when saving a profile from original Notepad, just name the file, without a .txt
extension, like this:

oo e [=[EIE< (e

File Edit Format View Help ® ’ ‘ » Computer » Local Disk (C:) » poker » data
// 6-pack version 11 updated 11/23/2014 - e — = — m—

custom Organize ¥ New folder

preflop

& Downloads - Name

// The following three Tines are user-variables for the | Recent Places

87 or hand = 86 suited or hand = 85
76 or hand = 75 suited or hand = 74
= 64 suited or hand = 54

suited or hand
suited or hand
suited or hand = 65 or hand
suited) raise 2 force

£, Local Disk (C:)

Doodle profile, in case you are using the Doodle as the £ . | 6pack
back-up. If not, no harm done in simply setting them true. | & Google Drive
when raises = 1 and lastraiserposition >= 6 L doodle
userearlyRaiser husng
when raises = 0 and calls >= 1 and firstcallerposition >= 4 Libraries Sie
7 and stilltoact >= 3 UserTrapl = = L omtt
when opponentisallin UserDead | Documents 5
when (hand = AA or hand = KK) and raises = 0 and calls = 0 & Music 3 . wildbill
and stilltoact >= 4 and random <= 33 raise force =] Pictures
v(lher] r:a;i\se(sj = Ohang calls =h0 Snd st'i'Htgacg <= 3 and " B videos

airinhand or hand = A or hand = KQ or hand = KJ suite
orq hand = K9 suited or hand = K8 suited or hand = K7 Do not add .txt to file
suited or hand = QJ suited or hand = Q9 suited or hand = & Homegroup name when saving from
Q8 suited or hand = JT or hand = 39 or hand = 18 suited or i
hand = 37 suited or hand = T9 or hand = T8 suited or hand Notepad
= T7 suited or hand = 98 or hand = 97 suited or hand = 96 1% Computer

|

when raises = 0 and calls = 0 and stilltoact <= 2 and File natge: 6pack

(hand = 86 or hand = 97 or hand = T8 or hand = 77 or hand
= 18) raise 2 force

Save as type: cuments (*.txt)

when raises = 0 and calls = 1 and (hand = AA or hand = KK
or hand = QQ or hand = 13 or hand = TT or hand = 99 or
hand = AK or hand = AQ suited or hand = AJ suited or hand
= KQ suited) raise 3 force

# Hide Folders




Notepad 2, however, does not automatically add the .txt extension when saving
the file. So if you are using Notepad 2, you need to include it when naming the

file, like this:

File Edit View Settings 7

DEQd| | & @

Ins@ecloww

1// 6-Pack version 11 updated 11/23/2014

2
3 custom

4 preflop

5

s // The following three lines are

user-variables

for the Doodle profile, in case you are using the
poodle as the back-up. If not, no harm done in

simply setting them true.

7 when raises = 1 and lastraiserposition >= 6

uUserearlyRaiser

swhen raises = 0 and calls >= 1 and
firstcallerposition >= 7 and stilltoact >= 3

UserTrapl

9 when opponentisallin userbDead
10
| 11 when (hand = AA or hand = KK) and raises = 0 and
calls = 0 and stilltoact >= 4 and random <= 33
raise force

12

13 when raises = 0 and calls = 0 and stilltoact <= 3
and (pairinhand or hand = A or hand = KQ or hand =

KJ suited or hand = K9 suited or
or hand = K7 suited or hand = QJ
Q9 suited or hand = Q8 suited or
= 19 or hand = 18 suited or hand
hand = T9 or hand = T8 suited or
or hand = 98 or hand = 97 suited
suited or hand = 87 or hand = 86
85 suited or hand = 76 or hand =
= 74 suited or hand = 65 or hand

hand = K8 suited
suited or hand =
hand = 3T or hand
= 17 suited or
hand = T7 suited
or hand = 96
suited or hand =
75 suited or hand
= 64 suited or

Ln1:87 Coll Sel0

6.59 KB ANSI |

CR+LF INS Defau

Automatically Loading Profiles

Pictures
Videos

+& Homegroup

f{-\ ‘ | » Computer » Local Disk (C:) » poker » data
Organize v New folder
& Downloads < Name .
| Recent Places
3 | bpack
L GoogleDrive  —
| doodle
. | hol1D84.tmp
~a Libraries
= & | holdem
|5] Documents
| holdem
&' Music
| holdem.ppl

(53] holdembot
| holdembot.exe.manifest
@ HoldemBotUserManual

m

| husng
%) msiltcf.dll
18 Computer "
&, Local Disk (C: e
= ik (G @) pacific888.dll
X PPLGuide
cj Network
|u
% BRW00242C30D5 R
| wildbill
/% MARTINE-PC
18 USER2-PC o
File ngfne:  Gpack.bet

Save as typi [All files (*.%)

“ Hide Folders

Do Add .txt to file name when
saving in Notepad 2

If you have a text profile you want to automatically load into every bot window
that opens, simply name it AutoprofileHoldem.txt (do not include the .txt if
naming it in original Notepad). Place it in the bot directory and it will always auto-

load.



Semi-Automatically Loading Profiles

When you go to manually load a profile, a default profile name will appear in the
Read Profile window: holdem_profile.txt. If you are manually loading a profile,

you need to type over this so it erases and is fully replaced. But you can name a
profile holdem_ profile.txt (do not include the .txt if naming it in original Notepad)

so that the profile name is always pre-loaded in the Read Profile window, which

will save you having to type the profile name in:

Holdem Edit Options Start! Succaint Mo Auto Play  Hide Game Type Purchase License  Download Latest Version

Shanky Technologies Holdem Version 7.7.5: Default
WARNING bonusbots.com is the ONLY legal site for the Shanky Bot proﬁle

Read Profile from File slle name, you

0S = Windows 7

checking display settings. / can hame
Screen Resolution = 1920 Q your profile
font smoothing set to 'Stan||| Read Profile From File: | {holdem_profile. txt g

No display setting errors d| this if you

To start playing: sit at a Hal i

Default profile read from fil|) g I Gance] | :Ikedtor casy
Profile: Doodle v105 ' oading

free hands played = 0

Manually Loading Profiles

To manually load a profile: On the bot menu first click on Holdem and then on
Read Profile. The above pictured Read Profile window will appear. Erase or type
over the default profile name, typing in your desired profile name instead.
Remember to always include the .txt extension when loading the profile!

Start! Hide

Holdem Edit Options Succint  No Auta Play Game Type Purchase License  Download Latest Version

et ihbligics fibidem VerSon i Always include .txt extension when
an echnologies Holdem Yersion /./. . -
WARNING bonusbots.com is the ONLY legal site for the Shanky Bot 10@ding profile name

0S = Windows 7 . —
checking display settings... Read Profile from File |

Screen Resolution = 1920 X 1080 |
font smoothing set to 'Standard’ . . T

No display setting errors detected Read Profile From Fif |Bpack tst

To start playing: sit at a Hold'em table and click 'start'
Default profile read from file Holdem.ppl I

Profile: Doodle v105 2k ol |
free hands played = 0

Whichever way you load your profile, remember it must first be located in the bot
directory with the bot (which should be at C:Poker\data if you didn’t move it).



Copying and Saving Profiles Using Notepad: Summary

1. Open the profile. Copy the code. Make sure you get all of it! A good way to do
this is by first right-clicking on the profile and then clicking on Select All before
clicking on Copy

2. Paste into a blank Notepad (Start > All Programs > Accessories > Notepad)
You can right-click the mouse now and choose Paste

3. Save As 'whatever' into your bot folder (inside C:Poker\data if you did not
move the location)

4. Load in the bot by going to Holdem > Read Profile and typing in ‘whatever.txt'

Alternatives to Step 4:

A) Save As 'AutoProfileHoldem' and it will load automatically as the default profile
every time you open a bot window

B) Save As 'holdem_profile’ and it will be the default name of the profile showing
in the Read Profile window, saving any typing

Do not add a .txt extension to the profile name when saving it from original
Notepad that comes in windows! Do add the .txt extension when typing in the
profile name in the bot’s Read Profile window!

Confirmation of Profile Loading

The bot will give you a message in the bot window confirming the profile was
“read” if it was loaded successfully. If not, it will give you a message explaining
why it was rejected (usually because the bot cannot find the profile, or there was
a PPL typo in the profile). Please look for the confirmation or rejection message
each time you load a profile, regardless of which method you use to load it.

If you get a message in the bot window that the profile was read then it
stays loaded! This doesn’t mean all the messages in the bot window will now
come from the profile that is loaded, however. Please note the default .ppl profile
and/or original root level programming are both still in the background, and will
still give messages saying what they would do in many situations before the
custom profile is even consulted for the situation. Pay attention to the actions
taken in the bot messages. When you see a user defined condition being
executed, referencing a codeline, that action is from the text profile that is loaded.
Also, many profiles still do defer some actions to the default profile, and even to
the root level programming (which is affected by option menu settings).



Auto-changing a profile mid-session

You can have the bot automatically switch to a different saved profile in the
middle of a session. This can be triggered when the table gets short-handed,
when a specified number of hands are played in the current session, when a
specified number of minutes are played in the current session, or when your
stack size falls below a certain level. To set this up go to:

Holdem: Auto Read Profile

...and enter the profile file name and choose which condition you want for
changing to that profile.

2.4 Using Opponent Stats from Poker Tracker, etc.

Our bot has the ability to scrape opponent names at some of our supported
poker rooms. There is a PPL variable which will allow you to alter actions based
on specific player names being active in the current hand being played. Because
this function works from the opponent’s screen name, it doesn’t matter which
stat-gathering software you use; all you need is a list of player names whom you
want to play a certain way against.

You can use as many of these player name lists as you see fit. So you can have
a list of known tight players whom you raise liberally, another list of known loose
players whom you play tight against, and a list of known maniacs whom you
simply check and call down with strong hands, all in the same profile.

See the PPL Guide for more information (this variable is opponent = and is
listed in the appendix under Numeric Valued Variables).



Detailed Instructions for
Holdem Bot

Thank you for taking the time to look at our program! We hope you enjoy it, and
that you decide to use it to increase your earnings from online poker.

3.1 Run as Administrator

Both the poker room and the bot need to be run as administrator. Otherwise the
bot is able to read the cards from the casino window but not able to click any
buttons. The bot will automatically start as administrator on Windows 7/8
machines. Always start the poker room by right clicking on its icon (which looks
like a generic program icon) and choosing the "Run as Administrator" option.
Note that you must do this even if you have administrator privileges since on the
above operating systems ‘Run as Administrator’ is not the same thing as having
administrator privileges.

3.2 Seat Position

At our supported poker rooms which sit you in the bottom position automatically
by default, you must remain in this seat position and not change even if the poker
room allows you to change the display so that you appear in a different seat. But
please also refer to the individual poker room instructions in the Quick Start
section of this manual for proper seating configuration..

3.3 Free Trial Notes

Your free demo is good for 200 hands and is mandatory prior to license
purchase. You don't have to exhaust the 200 hands but you do have to run it for
a bit.

After you have run the bot it will establish a Computer ID number, which can be
obtained by choosing the bot menu item Holdem: Get Computer ID. If you
exhaust the 200 free hands, this number will also appear in the last playing
session log file that the bot records. You MUST provide this Computer ID to us
when purchasing your license.



After we email you your license code, the bot will only work on the computer that
you provided the Computer ID for. You are only allowed to purchase one license
per computer. So make sure that you download and run the trial version on the
computer you plan on using it with! We are not responsible for anyone who
mistakenly purchases a license for the wrong computer, and no refunds will be
issued. No exceptions.

3.4 Where to Put the Program

There were five items extracted when you opened the file you downloaded: This
instruction manual, the PPL user guide, a .dll file, the default profile (in .ppl
format) and the bot program which is called holdembot.exe.

The installation program puts these files in a folder called C:\poker\data by
default. You can change the folder name during installation. Whatever folder you
specify is automatically created by the installer. Please do not move the bot from
the folder with the other files. Specifically, it must be kept in the same folder as
the .dll file that came with the download, or it will not function. If you want to
move it to your desktop for easier access, either create a shortcut (by right-
clicking on the icon and selecting the create shortcut option) or drag the entire
data subfolder to your desktop. If you do this, we recommend renaming the folder
to something like vacation (to rename a folder right click on its name and choose
rename from the pop up menu.)

Stealth Tip: The folder in which you have installed the holdem bot can be kept
on your desktop or anywhere else you like such as your C: drive or My
Documents. For stealth purposes you might want to bury this folder several sub-
folders deep from your C: drive and name them something that sounds like
vacation photos or organizing software, and also keep your license in that folder.
If you have already installed the bot in C:\Poker\Data you can copy the entire
Data folder to a folder several folders deep.

The .dll file included in the download must be kept in the same folder or directory
as the bot program (holdembot.exe) or the bot will not work.

3.5 Session Log

The bot records a log of every hand played. This is a text file that is created
automatically and placed in the folder or directory where you keep the bot
program files, the default location being c:\poker\data. It's simply named holdem,
(or holdem.txt with the file type extension). Each time you open the bot the
previous session is erased from the log and overwritten with the new session.



When you use the multi-table function, multiple session logs are created, one for
each table or tournament being played. These are named holdem2 and holdems3.
They are overwritten just like the 1-table log the next time you have two or three
tables going.

3.6 Which Games to Play

The bot supports all game types including heads up tables, single table SNG’s,
and all forms of multi-table tournaments (MTT’s). In MTT’s the bot will follow the
table changes for you as long as you don’t have an unhooked table open at the
time of the table change, or experience interference issues from other programs
or web browsers open. It is not recommended to multi-table while using the bot in
an MTT due to the higher chance of not following a table change if you do.

High stakes cash games and SNG’s are difficult to beat with or without a bot.
Most poker-botters stick to lower stakes cash games and SNG'’s. If you want to
bot higher stakes, MTT’s are the way to do it - as the strategy is not very different
in a high stakes MTT than at a low stakes one. We have a great free tournament
profile available you can use posted at www.bonusbots.com/mtt.txt.

3.7 Hiding the Bot

The second to last item across on the main bot menu is Hide. This causes all
open bot windows to vanish from your computer screen completely, but they will
keep playing for you while invisible. While in hide mode the bot not visible to
screen scraping programs and will not show as an application running on your
system either.

Before the bot hides itself, it will check your system for the availability of the last
six F-command keys on your keyboard to use for calling it back. For most users it
will start at F10, but if you have another program which uses F10 it will move on
to F11 and if that is also unavailable it will finally try using F12. The order after
that is F7, F8 and F9. Before the bot windows vanish a small popup window will
appear telling you which key command to use in calling them back, and you must
acknowledge this by clicking OK - then the bot will hide.

To call it back you must hold down the ALT key on your keyboard while pressing
the F10, F11, F12, F7, F8, or F9 key (whichever one the program told you to use
before vanishing).

When multi-tabling it is probably easiest to minimize the connected bot windows.
After all the tables you want to play are connected, use the Hide function to hide
them all.


http://www.bonusbots.com/mtt.txt

Stealth Tip: It is recommended to hide the bot most of the time when it is
running, and always when you are away from your computer. You also may want
to rename the bot to something other than holdembot.exe, preferably another
common computer application. Right-click on the bot program icon in order to do
this. See the Strategy section below for some specific ideas.

Please note that if you forget to call the bot back from hiding after a session, the
hidden window will come back up when you try to start the bot again.

3.8 Game Type Menu

The last selection on the main program window menu is for the game type,
meaning the Limit type of the game you are playing. The bot is unable to auto-
detect the game type at Bodog so assumes you are playing NL. For Pot Limit or
Fixed Limit games on Bodog it is recommended that you set this manually. For
other poker rooms you can just let it be on Auto Detect.

3.9 Options Menu

The bot includes many playing options that you, the user, can set. (Most of them
are only for No Limit and Pot Limit games.) These can be found on the main bot
menu by clicking on Options. You will notice the choices are organized into
logical sub-menus. Be sure to read Section 2 of this manual however, so you
understand what level of the bot instructions they affect. These are the most
important options:

MAX SESSION BY HANDS, TIME, & STACK SIZE (Sitout Options)

The first few options allow you to tell the bot to quit playing after a certain amount
of time, certain number of hands, or when your stack size grows to a certain
level.

BATHROOM BREAKS (Sitout Options)

You must set the bot to take breaks. This is under Bathroom Breaks on the
Options menu. The purpose is to mimic being human. You can set the interval
and the time of the break. The shortest allowed break time is 2 minutes. It is not
recommended to take breaks longer than 4 minutes as you are likely to get
removed from the table. A good setting for cash games is 3 minutes every 40-
120 minutes.



If you do not want the bot to take a bathroom break, such as when you are
playing in a tournament, simply set the interval to 900 minutes.

STACK SIZE RECOGNITION

Our Holdem Bot bot reads it's stack size and incorporates that into several of the
option settings. This is useful for playing a more aggressive game with a short
stack (especially in tournaments) and calling raises after your bet pot-commits
you.

Stack size is set by the number of big blinds on the option menu. You will notice
that it is read from the screen in dollar amounts however, and recorded that way
in its session log. Don't be concerned about this - the bot makes the appropriate
conversion in its calculations.

TOTAL INVESTMENT

The bots keeps track of how much it has invested in any given hand. There is at
least one option where you can adjust a setting by the bot's total investment. This
is useful for making sure the bot never folds when you are pot-committed.
BETSIZE ADJUSTMENTS (Aggressive Play Settings)

On the Aggressive Play Settings you will find two different option settings for
adjusting the standard bet and raise sizes that the bot will make when acting
from it's default programming.

The preflop setting allows you to tell it when you want to make pot-sized raises
preflop, based on a variety of factors including some random elements. The
default programming of the bot will make pot-sized preflop raises sometimes and
min-raises sometimes. You can adjust that here.

The post-flop setting allows you to enter a % number (which corresponds to %
of existing potsize) for changing the bot’s standard bet and raise size on the Flop,
Turn, and River. For example you might tell it to bet 100% on the flop (that is a
pot-sized bet), 75% of the pot on the Turn, and 60% of the pot on the River.

When a custom bet size other than 100% is chosen the bot will actually type in
the betsize and click Bet. When 100% is chosen it will use the pot button to bet or
raise the pot.

When 0 is chosen the bot will use its lowest level of default programming, which
is to bet the pot on the flop and if a half-pot button is available use that on the
Turn and River, otherwise bet the pot and the Turn and River as well. The default
settings for this option are 100 on the flop and 0 on the Turn and River so you
should adjust them to your liking if you don’t want pot-sized post-flop bets.



FOLD OR GO ALL IN OPTIONS (Aggressive Play Settings)

On the option menu you will find two Fold or Go All-In settings, for NL and PL
type games. These can be set to ALWAYS, invoked by number of opponents, or
by number of hands played in the session. When either of these settings are
triggered the bot will still check and fold as normal, but when it's action is to call
or raise it will attempt to go all-in. (This includes all programmed blind-stealing
and bluffing situations.)

Please make sure both of these options are set on default in game environments
where you do not want the bot to push all-in. Setting them on default turns them
off so the bot will play as normal.

Also, please see the Aggressive Tournament Setting further below which also
allows you to set conditions for pushing all-in, both preflop and post-flop, based
on certain conditions. The two Fold or All In settings are best for when you are at
the end of a tournament or have a short stack in a tournament.

You can use either of these settings in conjunction with the Super Tight option as
well. That would have the bot waiting for premium hands and pushing all-in
whenever it has one.

The difference in the two settings is how they are triggered.
FOLD OR GO ALL IN WHEN OPPONENTS (AFTER FOLDS) LESS THAN...

This setting is triggered by the remaining opponents in any particular hand. That
could happen any time regardless of how many players are sitting at the table, as
long as the set number of hands have elapsed in the session. It's a good choice if
you want to play the "Kill Phil" style of poker in a tournament. Note that the bot
might push all-in on the first hand dealt using this option if you don't apply it after
a set number of hands.

You can also choose to have this setting invoked only when your stack size falls
below a certain level. However please note that the active number of players in
the hand must still be below your chosen number for this setting to trigger, even
when your stack is small.

FOLD OR GO ALL IN WHEN OPPONENTS AT TABLE LESS THAN...

This setting is only triggered by the original number of opponents sitting at the
table. So if you have it set to less than 4, as soon as the number of opponents



are 3 or less the bot will always push all-in when it plays. This is a good choice
for finishing SitnGo's and Tournaments.

You can also choose to have this setting invoked only when your stack size falls
below a certain level. However please note that the number of players sitting at

the table must still be below your chosen number for this setting to trigger, even
when your stack is small.

*PLEASE NEVER SET BOTH OF THE FOLD OR GO ALL IN OPTIONS TO
TRIGGER. CHOOSE ONE OF THEM IF YOU ARE GOING TO USE THIS
FEATURE, OR BETTER YET USE THE AGGRESSIVE TOURNAMENT
SETTING INSTEAD**

ALWAYS CALL WHEN OPPONENTS RAISE IS BELOW (Aggressive Settings)

This is another setting on the user option menu that applies only to NL and PL
games. It's purpose is to keep the bot from folding to small raises by your
opponent when it would be foolish from a pot odds standpoint to do so. On the
river there is a hand value qualifier of best kicker or better for this setting to be
invoked; however on all other streets there is no hand strength qualifier.

There are two parts to it: One for measuring the opponent's raise against your
bet size, and one for measuring the bot's total investment in the hand.

There are three positions available for measuring the opponent'’s raise size:
20%, 30%, and 40%. Most players prefer the 40% option in most game
environments. So that means whenever you bet and somebody raises but the
raise is less than 40% of the amount you bet the bot will automatically call. (If you
are playing high-stakes cash games you might prefer a lower setting for the bet
size portion.)

These settings also apply to an opponent attempting to sandbag you by calling
your bet when they only have a few chips left and then betting their last few chips
out on the next round. The bot will remember that it was the last bettor or raiser
on the previous betting round in this case and apply the same settings you have
chosen.

The second part is a setting for always calling when your current stack size is
below a certain percentage of your total investment in the hand. The default
setting is quite low and we recommend setting it much higher - probably at least
75% - especially for tournaments. Otherwise the bot might fold for a raise with
one pair hands when you want to call.

The two settings in this window protect you against folding when you have
invested so much in the hand that folding would be undesirable. So if you bet say



$1200 in chips in a tournament and somebody with only $1400 chips raises all-in
the bot will call. Or if somebody raises large and you only have $200 left in chips
after making that same $1200 bet the bot will call. Or if you bet $1200 and get a
call from a player who only has $200 in chips left after he calls and he acts first
on the next betting round and bets his last $200 out the bot will also call,
regardless of what card hit the board.

SUPER TIGHT PLAY OPTION (Tighter Play Settings)

When this is checked the bot will fold all hands preflop except: AA, KK, QQ, JJ,
10-10, 9-9, AKs, AK, AQs, AQ, AJs, and KQs. These it will play as normal. This
setting affects Limit play as well as NL/PL. Note that if you also have the Fold or
All In setting invoked, it will just go all-in whenever it gets one of these hands and
fold the rest of the time.

Using this setting robs you of the sophisticated programming that has gone into
this poker bot. However some people like to play SNG's this way, and also if you
just want the bot to play super tight for the first couple hours of a tournament this
would be the way to go. (There are other creative uses for it as well.)

SEMI-SUPER TIGHT PLAY OPTION (Tighter Play Settings)

The same setting as Super-tight above but also includes all pocket pairs. In NL
games the bot will call preflop raises up to 3 big blinds in size with 66 and below
and up to 5 big blinds in size with 77 and 88.

To call larger size preflop raises with these same small pocket pairs you can use
the Set Mining option (below) in conjunction with this setting.

MINIMUM BET OVERRIDE (Aggressive Play Settings)

This affects post-flop play in No Limit and Pot Limit games only. This option lets
you decide how you want to deal with knuckleheads who make a minimum bet of
only 1 big blind. Please note that the selected action will only take place if the pot
size is at least 5 big blinds and your hand value is best high-card or better.

NO LIMP (Aggressive Play Settings)

This option will stop the bot from just calling preflop (unless it has already raised).
It affects all positions except the Big Blind, and works in Limit games as well as

NL/PL. You can choose how you want to handle the relatively few hands that the
bot would normally limp in with: Raise instead, Fold instead, or Raise sometimes



and fold the rest of the time based on various factors. Some players prefer to
play this way in cash games, especially at the 6-max tables.

AGGRESSIVE TOURNAMENT SETTING (Aggressive Play Settings)

Near the bottom of the option menu you will find the Aggressive Tournament
option. It is highly recommended that this option be used for all types of
tournaments. These particular option choices define conditions for having the bot
use the Bet Max button - in other words, shoving all-in.

There are two sections, one for preflop play and one for post-flop play. One
choice must be made for each section. The default position for both is off, so you
will need to make a choice for turning them on in tournaments.

The preflop section gives you specific hand lists to choose from. Note that the
first choice consists of only the top hands and also requires that there be a
preflop raise before the bot will go all-in. The rest of the choices loosen the hand
selection up progressively and do not require a preflop raise before raising all-in.

The post-flop conditions are not defined for the user. We have programmed what
we believe are the best post-flop conditions for shoving in tournaments. These
include top pair or better on non-scary boards and reasonably strong hands on
scarier boards. But you still must choose whether you want this option on, off, or
only on if there was a preflop raise (which is the first choice on the menu).

You can also choose to have either or both sections only invoked when your
stack size falls below a certain level. This is a great way to play tournaments,
pushing all-in with any reasonable hand when your stack is short.

We highly recommend starting MTT's with the post-flop aggressive tournament

option triggered when there was a preflop raise only, and the first preflop option
checked which contains only the top hands and also requires a preflop raise. As
the tournament progresses it is often wise to loosen both of these up.

The aggressive tournament setting options can also be quite effective in the
lowest-stakes cash games, especially the post-flop setting.

MINING FOR SETS (Aggressive Play Settings)

A highly recommended setting for cash games and the early stages of
tournaments. This option will make sure the bot always calls preflop with pocket
pairs 99 and under, and allows you to set the maximum size raise you will call
for. A good general setting is under 5 big blinds.



POST-FLOP IN BLINDS OVERRIDE (Tighter Play Settings)

When you are in either blind position preflop you can tell the bot to only play
good hands post-flop, starting with Top-pair third best kicker or higher. It is a tight
setting that rocks love. The setting is only invoked if there was no preflop raise, in
other words you got a free look at the flop and have nothing invested. This works
for both Limit games and NL/PL.

PREFLOP RERAISE OVERRIDE (Tighter Play Settings)

You can check this setting on or off. It only applies to situations where an
opponent has raised preflop. When checked, the bot will only reraise with AA or
KK and just call with all the other hands it might normally reraise with. This works
for both Limit games and NL/PL.

DISABLE SPEED FOLDING (Other Options)

By default the bot will speed-fold the weaker starting hands automatically in
speed poker games, which means it will not attempt to steal blinds with them in
late position, being as it does not evaluate position until it is the bot’s turn to act.
Speed-folding can be disabled on the bot’s option menu under Options > Other
Options > Disable Speed Folding if you wish to steal blinds instead. It will slow
the pace of the game some, but not too much since most of the speed comes
from not seeing the flop and having to wait for opponents to play out a hand.

3.10 Saving Profiles

You are probably going to want to use different option menu settings for cash
games, 1-table SNG's, MTT's with a decent stack, and MTT's with a short stack.
Once you go through and choose all the options you want for a certain game
environment, you can save them as a profile. That way you can get them all back
quickly without having to set them all again.

To save a profile, click on the first item on the main menu Holdem and then on
Write Profile...

A window will appear with the default name "holdem_ profile.txt"

If you only want to save one profile you may as well call it that, as this is the
default profile name for both saving and loading profiles. However most players
will want to save at least several profiles, in which case you need to rename
them.



For example, ¢ for cash games (save as ‘c’ load as ‘c.txt’), or s for 1-table SNG's,
m1 for the beginning of tournaments, and m2 for when you notice you are short-
stacked in a tournament.

To load a saved profile, go to Holdem: Read Profile...

...then just type in the name of the saved profile that you want to load, such as
"ml.txt" etc.

Please note that profiles are saved by default in the same folder/directory where
the bot program is kept. This makes loading them easy as the bot looks for them
in that location. Alternatively, you could save them somewhere else by specifying
the path - but of course you will need to specify the path to load it as well. For
example: C:\cash6max.txt.

3.11 Switching Profiles Mid-Session

You can have the bot automatically switch to a different saved profile when the
table gets short-handed, when a specified number of hands are played in the
current session, when a specified number of minutes are played in the current
session, or when your stack size falls below a certain level. To set this up go to:

Holdem: Auto Read Profile

...and enter the profile file name and choose which condition you want for
changing to that profile.

3.12 Custom Coding Profiles With PPL

Our poker bots support user custom profile programming, in addition to the
settings on the option menu. This feature is not really necessary as our poker
bots come out of the box programmed to play poker well, and also have the
ability to create many different playing styles by adjusting the decision making
process right from the option menu.

But for those wanting even more control this feature will allow you to completely
program all of the bot's decisions yourself. The process is easy to learn and it
has resulted in the creation of a marketplace where users of our poker bots trade
their custom profiles with each other. If you are interested in this please read the
PPL User Guide, a pdf file that you should have received with the bot download.



3.13 Setting Your Own Default Profile

There is an additional feature that will allow you to have a certain profile be the
default profile that every bot window will use without having to load a profile at all.
All you need to do is save whichever profile you want for the default profile as:

AutoProfileHoldem.txt

...in the same folder as the bot. When a text file titled AutoProfileHoldem is
detected in the same folder as the bot, it will load automatically into every bot
window you open. You would then need to load a different profile only for the
tables that you want to use a different profile at.

3.14 Multi-Tabling

You can currently play up to six tables at a time on all our supported poker rooms
(any exceptions are mentioned in the settings adjustments for the poker rooms
sections). Even with small monitors and tables overlapping you shouldn't have
any trouble multi-tabling.

Table Positioning Tip: If you have a big screen you should try and position the
tables so that there is minimum overlap between them. On smaller screens you
should at least position the tables such that the button areas do not overlap.
Position the 2" table window such that it is a little (about two inches) to the right
of and a little (about 2 inches) below the 1% table and so on. However even if the
tables fully overlap, the bot windows will stay connected and still play them all.

How many tables you can play before getting errors depends on the poker room,
your monitor size, and the configuration of your PC system. Most people can play
at least two or three tables, but many can play all six. When multi-tabling you
should arrange the tables on your screen so that they are staggered enough that
the buttons do not overlap each other, but also so no part of the table is pushed
off screen.

Multi-tabling is accomplished by opening multiple bot windows and hooking them
to each table, one table at a time. Here is the procedure:

Get into the first table as normal and start the bot, but don't hide it yet. Instead,
get into a second table and separate it as much as possible from the first table on
your screen (without moving any part of it beyond the edge of your monitor).
Then, on the bot's main menu go to:

Holdem > New Window



This opens an additional bot window which operates independently. You can now
minimize the first bot window if you like. When you press start on the second bot
window it should connect to the new table; however on occasion it may ask you
for the table (or tournament) name. This is case sensitive. It will then connect and
you can repeat this process for additional tables if you like. After connecting to as
many tables as you like, click Hide on any of the bot windows and they will all
hide.

Each window operates independently so you can play different games, different
game environments, and load different profiles in each window. However you
cannot multi-table between poker rooms. All your tables need to be at the same
room.

Please note that the bot handles table changes in MTT's automatically at all the
poker rooms and does not need you to be there to enter the new table number as
you do when opening a new bot window for multi-tabling. However we do not
recommend multi-tabling MTT’s with the bot unless you are going to be able to
semi-monitor the computer. This is because if you have a table change at more
than one event at the same time, both bot windows may stay disconnected as
you will then have multiple unconnected tables open.

3.15 Waiting for a Table

The bot has a function to wait for a table to appear before starting to play. This
option will appear if you click start on the bot and it cannot find a poker table
window to hook itself to. It is useful for registering for tournaments and SNG'’s
before they start, so you can set the bot to play once they do and just walk away.

Please note that the tournament must be a type where you are seated
automatically and the table appears with you in your seat when it is ready to go.
At some tournaments at some of our supported rooms you must wait and click on
a popup window to take your seat and this feature will not work at those. How
well this feature works depends on which poker room you are playing at, which
type of tournament you are playing, and your individual PC setup. So please
experiment with it before trusting it to start playing for you.

Please Note: You cannot wait for multiple tables and therefore should use this
feature only to play one table at a time. Please do not attempt to play multiple
tournaments using this feature.



4. Running the Program

Winning Poker Network
(America’s Cardroom, Black Chip Poker, True Poker, 5 Dimes Shark Tank)

Note: Our bot only works with Windows 7 at this network, so if you have
Windows 8 you should use a VM. Also, it can currently play a maximum of 2-3
tables at these rooms (three on most desktops, two on most laptops). While you
can hook additional bot windows to tables, you will get “unable to read cards”
messages on one of the tables if you attempt to play 4+ tables.

Also Note: Your screen name cannot contain any symbols in it. This poker
network allows symbols in screen hames such as $ and ?, but our bot will not
work properly if your screen name contains characters other than letters and
numbers (upper or lower case letters is fine). In addition, your screen name
cannot contain the word ‘holdem’ in it.

The bot will resize the table to how it needs it as soon as it is attached. This is to
make multi-tabling easier, as the default table size fills the entire screen. We find
it easiest to resize the table to the minimum manually, before starting the bot,
especially when multi-tabling. This way, you can move the table location first.

There are three crucial option settings for the poker table that must be set in
order for the bot to read everything.

4. The poker table chat must be set to display on the table in the lower left
window, not ‘info’ or ‘stats’. It cannot be detached to the side-dock either.
Also, never click on the poker chat scroll bar on the side of the chat. The
table should look like this, with the chat bubble highlighted in blue:




5. From any poker table, bring up the options window by clicking on the gear
icon on the top left. In this window, on the General Tab, under Chat
Options, make sure Show dealer chat is checked:

General ]Themes l Sounds I Buy In/Top Up I

~Chat Options
[ Show players chat
[V Show dealer chat
I~ Show observer chat
[V Winning hands summary

~Game Options
[V Show Promotions
[V Show Animations
IV Auto switch between tables

|

- Display Hand Hint -
[V PlayMoney Tables
[V RealMoney Tables
IV Toumaments

—Other options
[V Show The Beast Points




6. Then, from the Themes tab, make sure the 2-color deck is checked:

General Themes ISoundsI Buy In/Top Up

i~ Table Background
o -

Card Settings -
{* 2 color deck " 4 color deck

A K

o PV 20 N i&? 190
o BT

No other settings matter. Don’t forget to always start the poker room software to
run as administrator. You can set it so it always starts that way; for instructions
see: http://bonusbots.com/support/index.php/topic,6734.0.html

Rakeback: Some of the poker rooms on this network offer a 27% rakeback deal
which you can get by following this link: http://tinyurl.com/I6x9cph



http://bonusbots.com/support/index.php/topic,6734.0.html
http://tinyurl.com/l6x9cph

Chico Poker Network
(BetOnline, Sportsbetting.ag)

Note: BetOnline cash tables have an annoying blackjack table attached on the
right-hand side and there doesn’t appear to be any way to get rid of it. No big
deal, as it doesn’t bother our bot.

The bot will resize the unhooked table to where it needs it as soon as it is started.
This is to make multi-tabling easier, as the default table size fills the entire screen
on most monitors. Don’t worry -- the bot can still see everything even if you can't.
When multi-tabling the tables can overlap if necessary, but it's probably wise to
stagger them a little so the betting buttons don’t overlap.

From the poker room lobby, click on Options and set as follows:

Options
Language > English
Table Background > Stadium
Animations > On
4-color deck — Do not check!
Tile Windows — Do not check!

Lobby Cashier History My Bonuses | Options | Help
Languages » . 7

7 tachum : K\ ‘

| Table Background | © y
BETUNLIN, - SIS 110 1 BEONLNE
Anmimations » g

4-Colour Deck CTRL-O
OMAHA  TOURNA} . windows CTRL-T
ALL STAKES Import Player Notes...

TABLE NAME STAKES LiMIT SEATS | PLRS v | WAIT AVG POT FLOP %

Dumh and Dumber $0.01/0.02 ML 10 10 1 $0.58 43% oy B Z 0 ll

Transcendence $001002 N 10 10 1 $0.57 32% 100% SLOTS MATCH BONUS
24 5001002 N 10 10 1 $0.67 39%

James Bond $001002 N 10 10 3 $1.91 44%

Ertourage 001002 ML 10 10 1 $0.51 42%

Paycheck $002004 N 10 10 3 $1.03 49%

Clash of Empires $002004 ML 10 10 2 $1.05 52%

Atnie $003006 ML 10 10 0 $1.53 45%

Chuck Noris $003006 ML 10 10 0 $1.54 7%

The Rover $0.05010  NL 10 10 1 $2.49 28%

The Giver 5005010 ML 10 10 1 $2.43 29% P l Av " I]w
Tammy $005010 N 10 10 1 $2.35 25%

No Limit Pat Limit Fixed Limit Head's Up Fu Empty |

No other settings matter. Don’t forget to always start the poker room software to
run as administrator. You can set it so it always starts that way; for instructions
see: http://bonusbots.com/support/index.php/topic,6734.0.html



http://bonusbots.com/support/index.php/topic,6734.0.html

Full Flush Poker
(Equity Network)

Note: Full Flush uses the same poker room software platform as the Chico
network above (Betonline & Sportsbetting.ag) but operates on a different network
so has different games and players.

The bot will resize the unhooked table to where it needs it as soon as it is started.
This is to make multi-tabling easier, as the default table size fills the entire screen
on most monitors. Don’t worry -- the bot can still see everything even if you can’t.
When multi-tabling the tables can overlap if necessary, but it's probably wise to
stagger them a little so the betting buttons don’t overlap.

From the poker room lobby, click on Options and set as follows:

Options
Language > English
Animations > On
4-color deck — Do not check!
Tile Windows — Do not check!

Lobby Cashier My Bonuses [Options] Help

Languages 4'@‘:
CASINO LIVE CASINO

Change Table Background...

3 MONTHLY POP
Sound a ACCUMULATOR m
Animations '@ On # Running Il Completed Il

4-Colour Deck CTRL-O Off
Tile Windows CTRL-T Active Table J0 BIG NIGHTLY FREEROLL

; > I Import Player Notes...
lin 51 minutes  $2,000 GTD BACKZBACK 2 q  $2.0U+pU.00 - 4 T F1$300 BIG NIGHTLY
3001 27 19:02 $25 FREEROLL ON DEMAND 1 POP
{Oct 31 11:02  $1,000 Dep/Reload FREEROLL -
io:t 27 18:22 $5000 HIGHROLLER SPECIAL Reg $50+85 Gold
%om 2718:22 $2,000 LATE NIGHT 3 Reg  $5.50+$0.55
Oc‘t 27 19:02 $500 GTD $2 Special Reg $2+$0.20
{Oct 31 14:02  $5K HALLOWEEN BOUNTY TREA Reg $15+81 .50
;001 27 20002 $1500 GTD AFTER HOURS Turho Annc  $4.50+30.45
|Oct 27 21:02  $200 GTD Turbo RebuyiAdd Annc  §$1.60+50.16
:'Oc:t 27 21:02 $25 FREEROLL ON DEMAND Annc 1 POP
|Oct 27 23:02  $25 FREEROLL ON DEMAND Annc 1 POP

Deposit Freeroll Tick

Tournament Lobby

LOADS GET 100% up to $1500 PLUS up to 30% CASHBACK... TOURNAMENT PLAYERS CHECK OUT THE NEV

No other settings matter. Don’t forget to always start the poker room software to
run as administrator. You can set it so it always starts that way; for instructions
see: http://bonusbots.com/support/index.php/topic,6734.0.html



http://bonusbots.com/support/index.php/topic,6734.0.html

Bodog / Bovada Poker (Including Chinese Bodog room)

Note: Our bot uses “OCR technology” to play at Bodog and Bovada, which is
different than the technology used for supporting our other poker rooms. This
means that the bot is dependent upon reading information from the screen and
therefore will be more sensitive to monitor and display settings. Tables can still
overlap when multi-tabling, because the bot brings the active table to the front
and takes a screenshot when it is your turn to act.

However, when playing more than three tables you might see timing issues when
you have to act at more than one table at the same time, as the multiple tables
waiting for your action fight each other for the front view. In these cases the bot
may take longer than the normal 2 seconds to act, and in rare instances may
even time out without acting. This looks quite natural however, as human players
often have the same issue under these circumstances. Also, this issue will be
dependent somewhat on your system resources. Most people can play at least
three tables without noticable timing issues.

Lobby settings: You must set the Game Play Settings tab exactly as shown
below, at both Bodog and Bovada, under the Preferences options in the lobby.

Preferences

(Pres to close)

About This Software

Tahle Settings

Game Play Settings Default Buy-in

Game Play Settings

Show Pot Total
Display the Pot Total for each hand above the main pat.

Show Bet Value

View your opponents numeric Bet Values along with their
chips for each round of betting.

M Show Hand Strength

Display your best S-card hand to the right of your pocket
cards,

E Show Table Spotlight

Turn on the Spaotlight to follow the action at the Paker table.

E Show Game Play Animation
Turn on Game Play animation such as chip and card
moverments,

M Rabbit Card

Displays the next card that would have been dealt after the
hand has ended,

Language

English |v|

M Folded Hand Display
Show your folded pocket cards until the end of each hand.
Cpponents will not see them.

M Use Four Colored Deck
Use a 4 colored deck. Clubs will be shown as green and

diamonds will be blue.

M Disable Enter to Bet
Prevents the keyvboard Enter key from placing a bet.

M Disable Pop to Front
Prevents the table from popping in front of other windows

when it is your turn,

B Auto Muck Hands

Always muck losing/uncalled hands.

M Enable Fold and Show

Enable the ability to fold and show your hand at the
showdown,




In addition, on the Table Settings tab the background must be set to red.
These Preferences settings from the lobby are not optional and must be set
properly in order for the bot to function at Bodog/Bovada.

Make certain that you do not collapse the box on the table screen which shows
the options for auto-posting blinds and sitting out! If you do, the bot will not be
able to use the sit-out functions such as the bathroom break settings. That box
looks like this:

b -
@ Auto-post blindfante

@ sSit out next hand

See that little arrow above those check boxes on the right? Stay away from that!
If you click it, that entire box collapses and hides the sit-out options. If they are
not visible on the screen, the bot cannot check them and follow sit-out
commands.

Do not enable “preferred seating” on the Table Settings tab! It doesn’t matter
which seat the bot is in, but the preferred seating function may hinder the bot’s
reading ability in some situations.

Troubleshooting: If you have correctly followed the above setup instructions
and the bot cannot read the cards (and therefore will not act), then it is highly
likely that a windows variable has been installed on your PC registry from
another downloaded software program, which is interfering with the bot’s ability
to work properly at Bodog/Bovada. In this case, the bot should return a warning
message about the presence of this file, which is unnecessary and safe to
remove. You can find instructions for removing it, plus a link to a free app which
will remove it for you, here:

http://bonusbots.com/support/index.php?topic=5318.0

Non-standard systems may have trouble trying to run the bot at Bodog/Bovada,
due to the nuances of using OCR technology (for example, a laptop + external
monitor or a Netbook PC). You might play around with the resolution and display
settings in these cases.

English language must be used.


http://bonusbots.com/support/index.php?topic=5318.0

888 Poker & WSOP Poker

(Includes Spain 888.es room, Chinese version, 888 New Jersey, WSOP Nevada,
WSOP New Jersey, WSOP U.K.)

Important: The older version 24 of the poker room software is required for
our bot to work on the 888 rooms. Most of you should be able to downgrade to
that version via this link:

setupspoker.images4us.com/setups/888poker/EN/p-1-en-4-6.17-
0/24/SetupFiles/GIB/FULL/888pokersetup.exe

Please Note: For the first hand dealt in any game at this poker room, the bot’s
stack size, position, and opponent count will be unknown and/or incorrect for the
first hand only, but should correct from the 2nd hand onwards.

You must set the following display options on the poker client from the 888 poker
lobby including the preferred seat positions. These are all critical and are not
optional in order for the bot to function properly.

Set the Game Settings tab as follows:

Table layout Personal image Garmne settings Game display Yideo § Audio

M Open lobby once a table is closed

ECE -
ixee |

Language: 3
M Show casino games button Default minimum bet:

M Hide bankroll balance
HE BEHEE = ™ Keep my hand histary in:

selsasih.vrampataoangacfiern i
P —

M Disable shortcut keys

™ Show folded cards

O Upon sliding the mouse over the name plate
® 25 faded cards until the end of the round

Tirne bank activation
O Autornatic
® Manual

when it's my turn to play:
™ Pop up the game window
™ Flash the task bar

When table screen is chosen, set focus on
® Chat
O Betting box

Days to keep hand history: 30 |

Tournament auto Rebuy/Add-on options
MW 2uto Rebuy

M 2uto Double Rebuy

M Rebuy Whenever Possible

M Auto Add-on



http://setupspoker.images4us.com/setups/888poker/EN/p-1-en-4-6.17-0/24/SetupFiles/GIB/FULL/888pokersetup.exe
http://setupspoker.images4us.com/setups/888poker/EN/p-1-en-4-6.17-0/24/SetupFiles/GIB/FULL/888pokersetup.exe

Set the Game Display tab as follows:

Table layout Personal image Game settings Game display Video § Audio

M Hide chat callouts Preferred seat:
M Show best hand
& Show final table in special background

M Progress bar settings

o Show bonus bar by default, and status bar when there
are no bonuses

® Show status bar at all times
™ Play sound effects
O al
® notifications only
 Enable animation
M Enable extra visual and animations features

Snap animation
O Revolve
® Fade
® [No animation

Table layout Personal image Game settings Gamne display Video f Audio

M Hide chat callouts Preferred seat: [6Seats |k
™ Show best hand

™ Show final table in special background

™ Progress bar settings
o Show bonus bar by default, and status bar when there
are no bonuses
® Show status bar at all times
™ Play sound effects
O &l
® notifications only
 Enable animation
M Enable extra wisual and animations features
Shap animation
O Revolve
® Fade
® Mo animation




You must have the English language selected on the Game Settings tab for the
bot to work here (this includes the Spanish and Chinese rooms), and you must
have your windows language set to English/US.

You must select the preferred seat for each table type on the drop-down list as
shown above! For all table types except 6 and 8 player tables, it is the bottom
center seat. For 6 and 8 player tables, it is the right-bottom seat. In other words,
if a bottom center seat exists you must be seated in it! If not, you must be
seated in the bottom right seat!

Finally, set the Table Layout tab as follows:

ﬁTSCf ting

Table layout Personal image Game settings Gamne display Video § Audio

Choose your table theme

Choose your deck | o ‘ ) fr
Wr"'

Choose your cards' face [ K K — K
¢ ¢\ T
. ek ICK

™ Enable action colour on name plate M Save layout
M Do not show personal images on table ™ Use Snap theme

M Full card view

Make sure that on the Video/Audio tab you did not check the box that says
Show final table in special background, or the bot will not be able to play the final
table in MTT’s!

Please remember that 888 Poker must be run as administrator on all operating
systems except XP. You can set any program to always run as administrator
when opened; for instructions go here:

http://bonusbots.com/support/index.php/topic,6734.0.html



http://bonusbots.com/support/index.php/topic,6734.0.html

iPoker Network

(William Hill / Ladbrokes / Betfair / Titan / TitanBet / NetBet / Bet365 / Boyle /
Winner / Paddy Power / Everest / Sisal.it / Titanbet.it / Turbopoker.fr / Everest.fr)

This setup is for all supported iPoker network rooms, including the French and
Italian only rooms. These settings adjustments are all critical and must be
followed in order for the bot to function properly.

Please note that France residents need to use the English version of the poker
clients at all three supported France rooms (including EverestPoker.fr). However,
Italy residents must use the Italian version of the poker clients at both supported
Italy rooms.

Poker Client Setup

Go to Options > Settings and on the Chat tab check all the options, as follows:

Settings

Lobby Show Dealer Chat
Show Player Chat
Show Observer Chat
Show Summary
Show Card Images
Chat Show Player Actions

Table

Avatar

Cards

System Chat - view bubbles

Audio

Casino games
BackBet game
Table Timeout

Multi Tables

Cancel

=

(Note: The player chat and observer chat can be unchecked if desired, and may
improve bot performance, especially when multi-tabling.)



Next, go to the Multi Tables tab and set the options as follows:

a

Settings

Lobby Take Focus from applications

Table Take focus from other table

B set focus on bet amount
Avatar .

B Keep focus on Chat and Motes
Cards
Ch
System

Audio

Casino games

Table Timeout

Multi Tables

Settings

Lobby General

Yiew Hand Strength
Show Folded Cards
Show All-in Odds
B Enable Spotlight

Audio Remember table positioning

Casino games Actions

BackBet game B Display Warning for Large Bets

Table Timeout Auto muck

g Auto Top-up (<
YILICH T ables
Configure betting buttons

0K




Important: If a Configure betting buttons link is available near the bottom of
the Table tab, as above (some iPoker rooms have it, some don’t), you must click
that and then configure your betting buttons as follows:

I

Configure betting buttons

3
Post-Flop

Buttons 1 50
Buttons 2 |20 - 100 |

Buttons 3 Max > Max v

Cancel

L® =

If you do not configure Buttons 2 and Buttons 3 as shown above (for the iPoker
rooms which have user-configurable betting buttons), there will be no Bet Pot or

Bet Max buttons available on your screen, resulting in the bot’s inability to follow

these commands.

Also Important: If a Widgets tab is available, the Show Widget Bar setting
must be un-checked at every iPoker room (except for Titan):

Settings

Show BackBet game
B show Widget Bar

Lobby
Table
é’ﬁwahar
Chat
System

Audio

Widgets
Multi Tables

Cards

m———
0K Cancel




At Titan Poker (including TitanBet.it) The Show Widget Bar setting above must
be checked!

None of the other settings on any of the other tabs are important for the bot, so
they can be set as you desire.

Windows Settings

Both the bot and poker client must be run as administrator for Vista and Windows
Seven machines (see section 1.1). The bot automatically runs as administrator
on Windows Seven systems, but the poker client still must be opened that way
every time. On Vista systems, both the bot and the poker room software must
always be opened to run as administrator, using the right-click mouse option.

Your Windows language/regional settings must be set to English/U.S for all

poker rooms (see section 1.2) with the exception of the Italian and French-only
iPoker sites that are supported.

Poker Table Chat Window: Important!

There are two sizes that the poker table chat window can be and the bot needs it
on the larger of the two sizes in order to read the dealer messages (please note
that it can still read them even if the tables overlap and the table is covered by
another table, however). This is very subtle and easy to miss, so please do play
around with the poker table chat size to the point where you understand how to
expand and collapse it. This does not apply to Speed Poker tables, however,
which use a different type of chat window that is not resizable — but the poker
client will collapse all poker chat windows after playing on a Speed table,
requiring you to expand them again the next time you play a non-speed table,
including any tournament!

Speed Poker

The bot supports Speed Poker tables at all our supported iPoker rooms. They
can be multi-tabled in the usual manner. However, please note that after playing
on a Speed Poker table, the poker table chat window will then be collapsed at all
non-speed tables (including tournaments) and will have to be expanded again
manually before the bot will work at them again.

Also, the bot will speed-fold the weaker starting hands automatically, which
means it will not attempt to steal blinds with them in late position, being as it does
not evaluate position until it is the bot’s turn to act. Speed-folding can be disabled
on the bot’s option menu under Options > Other Options > Disable Speed
Folding if you wish to steal blinds instead. It will slow the pace of the game some,



but not too much since most of the speed comes from not seeing the flop and
having to wait for opponents to play out a hand.

Tournaments

At the iPoker rooms, the bot will ask you for your screen name when you play a
tournament. Be careful of typos! If the name you enter does not match your
screen name at the table exactly, the bot will not be able to read your stack size!

Sisal.it and Titanbet.it

The bot also supports the Italian iPoker rooms Sisal.it and Titanbet.it, for Italy
residents only. These are the only Italian iPoker room currently supported, and
the bot works with the Italian language only here. The same other iPoker setup
instructions apply.

TurboPoker.fr, EverestPoker.fr, and Unibet.fr

The bot also supports these three French poker rooms, for France residents only.
You must use the English speaking poker clients, as the bot only reads English
at these three sites. All other iPoker setup instructions apply.

Rakeback

Private (non-advertised) rakeback deals are available for certain iPoker rooms
and they are juicy! Check our support forum for the latest offers.

iPoker Troubleshooting

Problems reported using the bot at any of the iPoker network rooms almost
always end up being due to one of these five things:

1. Not having your Windows language set to English / US (English / UK is no
good because the betting amounts need to have decimals, not commas).

2. Not using an English speaking version of the poker client.

3. Having collapsed the poker table chat window. This is the most common
error. There are two sizes that the poker table chat window can be and the bot
needs it on the larger of the two sizes in order to read the dealer messages in the
poker table chat (please note that it can still read them even if the tables overlap
and the table is covered by another table however). It is quite easy to accidently



collapse the chat on the poker table. If you have done this, some arrows will
show on the right side of the chat that you can click and expand it back again.

4. Not having configured the betting buttons in the poker client properly,

resulting in no 'pot’ or 'max’ size betting buttons available on the screen for the
bot to use. See above screenshot of how they should be configured (if you are
playing at an iPoker room which has incorporated that feature in the software).

5. Failing to start the poker room software to run as administrator. This must be
done every time it is started. You can set it so it always starts that way; for
instructions go here:

http://bonusbots.com/support/index.php/topic,6734.0.html

6. Having the widgets setting enabled if you are not playing at Titan, or having it
disabled if you are playing at Titan.

7. A typo in entering your screen name on the bot for tournaments, resulting in
the bot being unable to read your stack size. The screen name you enter must
match your name displayed at the table exactly.

8. Having checked the “set focus on bet amount” box on the multi-tables tab.
Don’t do that!
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5. Miscellaneous

5.1 Other User Options on the Bot

There is a sit-out option which should normally be set to 1 so that it never sits
out. In SNG's and MTT's this setting is ignored anyway. The exception would be
if you want to experiment sitting out short-handed in cash games, especially
higher stakes ones.

**Recommend setting Sitout Option to 1 (never sitting out)**

The other option menu choices have to do with decision programming, more
specifically the bet sizing and the minimum strength hand you want the bot to
play in different situations. The long-term profitability of the bot in NL and PL
games WILL depend on which options you select for which game environments.

In general we recommend selecting looser options in lower stakes games and
tighter options in higher stakes games. Please refer to the strategy section below
for specific recommendations on how to set these options for different game
environments. You might also want to hang around the forum and watch people
posting success stories to see if they reveal what options they are using.

5.2 Additional Notes

If you have any problems with the bot, try setting the resolution of your screen to
1024 X 768. The bot has been tested only with this resolution and may or may
not work correctly with other screen resolutions. You can check and change the
screen resolution by right clicking on empty space on your desktop and choosing
the property item from the pop up menu. Then choose the settings tab.

Don't check email or do other stuff while the bot is running. Have all your browser
windows closed.

**Especially don't have a browser window open at any kind of poker site as
the bot can get confused**

Stealth Tip: Please, please don't run the bot for more than 12 hours at a time.
This could alert the poker room to the possibility of bot usage and cause
problems for all of us. Bot responsibly!



Ignore the Succint/Verbose setting on the menu. All this does is change the
amount of data recorded in the session log.

5.3 Rakeback

Rakeback is necessary to show a worthwhile long-term profit for most cash
games. Please register for your poker accounts through a reputable rakeback
provider. If you don't have a bonus or rakeback going for you, you should only
play SNG's or Tournaments.

You can get rakeback through our favorite provider by following this link:

http://tinyurl.com/b3jrz4

Get a Neteller Account: If you are not a USA citizen, it is highly recommended
that you have a Neteller account to use for moving funds in and out of your poker
room accounts. You can register for one using the following link and will receive
occasional special offers for doing so:

http://tinyurl.com/7cjjv5h
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Introduction

July 2010 Note: This strategy guide is now a couple of years old and may be
starting to get a little outdated. However it is still a good idea to give it a read.

Hopefully, the reason you have this guide is because you downloaded one of our
poker bots. If not, please go do so at www.BonusBots.com. The download is free
and will work for 200 hands before requiring a license purchase.

The purpose of this strategy section is to help you use our product profitably, in a
manner that both suits you and makes the endeavor worth your while. We
believe we are selling the best pokerbots on the internet, but if you don’t use
them correctly they might not do you any good (other than having a really cool

toy).

We have been selling an Omaha/8 bot since late 2006 when we started selling
online gaming bots. In early 2007 it became clear that the real demand was for a
Hold’em bot, as that’s where all the action is in online poker. So we started
building one. This project proved to be much bigger than we ever could have
anticipated.

One year later, we finally released it. And it’s not like we dilly-dallied on this thing
either. It took a year of constant development, testing, and revising before we
had something we thought was good enough to sell. Our Hold’em bot is the
cumulative result of an incredible effort like you can’t even imagine. That was in
the spring of 2008.

Fast-forward another year to spring of 2009. The original released product, while
very good, has been constantly improved. To the point even of a special
programming language being added to it which allows the user to control 100%
of it'’s actions if they so desire. Custom profiles are being cranked out by our
users and posted in our support forum on a daily basis.

This bot takes previous round betting action into some of it's playing decisions. It
knows how many players are still in the hand, and what it's current position is. It
makes wise continuation bets and check-raises in good spots.

It also randomizes many of it's decisions by using card colors. For example, the
bot may raise or fold in some places depending on whether it’s first hole card is
black or red. You simply won'’t find these kinds of features programmed into other
commercially-available poker bots. (Of course they didn’t take a year to create,
either.)
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As the product improves, the license fee rises. Consequently we see it as a very
good investment, whenever you happen to purchase it.

Types of Poker Bots

There are three basic types of poker bots on the market.
Win Hold’em (or Open Hold’em)

These are products that click the correct buttons but don’t know what to do. It's
for programmers, to give them a jump start and allow them to program the
playing instructions. You need to know programming code to complete the
product, C/C++ | believe. Poker rooms know about these and are actively
scraping for them, so you need to combine the use of two PC’s in order to run
them (one holds the Win Hold’em program, the other holds the poker room
software). It's rather complicated and involves a lot of effort to pursue.

Please note that our poker bots can now also be custom coded by the user, for
those so inclined. So we are essentially offering the same thing now, except that
our products come with winning programming already installed (in addition to a
large option menu which lets you quickly adjust the play for many situations).
Profiles are easily saved and little bits of custom code can be added to change
the behavior here and there if you wish.

So a complete user-designed profile for our poker bots can now be created by
anyone who has a mind to in a matter of hours, as opposed to a matter of
months like it takes with Win Holdem or Open Holdem. Our language is very
easy to learn even for people with no programming background. This is not
necessary but is a nice extra feature. More about this below.

Third Party Brains

This category includes the OPI bots (OPI stands for Online Poker Inspector; or
more specifically Online Hold’em inspector). The bot software uses a third party
brain to make decisions, usually some type of poker odds software that gives
playing advice based on the situation. The problem with these is that there are
not enough variables in the poker advice programs to make a good bot.

Low limit games at certain poker rooms are full of these OPI bots. Our Hold’em
bot will destroy them over time.



Self-contained Bots

That’s what our bots are. | have purchased a couple others that fit this category
over the years, but they always turned out to be junk. | am unaware of any other
product currently being sold in this category. They are, after all, quite difficult to

create.

To run our bot you just open the program, choose your playing options, open the
poker room, get in a game, click start and minimize the bot program. (Our bots
are disguised as common computer applications and thus any poker room
scraping for them will only see that you have Internet Explorer, Mozilla Firefox,
Microsoft Outlook, the Microsoft generic program icon, a DOS window, or
something like that open on your computer while you are playing.)

Staying in Stealth Mode

Because it’s entirely possible that the poker rooms might start looking for our bot,
it's wise to always have it hidden while playing. It also might be prudent to have
the poker room software open and maybe even the table you want to play at
open for a couple minutes before joining.

Better yet, get into a game and play for a few minutes before opening the bot
software and then quickly start and hide it. Have any settings from the option
menu that you are using selected ahead of time. We really don’t anticipate any
problems in this area but it's wise to be careful.

When the program is in Hide mode it doesn’t show as an application running and
is not visible anywhere on your computer screen. Use the Alt+F10 command to
bring it back (or whichever F-key command the bot tells you to use before it
hides). The software also incorporates several other stealth features to avoid
being profiled as a bot, including:

* Random Pixel Clicking

» Random Delay Time Before Acting

* Using Preflop Fold in Turn Buttons sometimes (only at certain poker rooms)

* Very, very occasionally typing “nh” in the chat window when it loses on the river
» Scheduled Bathroom Breaks

Because of these features, it is extremely difficult to detect.



Sit-out Options

On the option menu of our pokerbot programs you can choose to have them sit
out when the players at your table fall beneath a certain number. When the
player count goes back to your selected number the bot will attempt to sit itself
back in. This usually works, but not always. And it is very possible to get
removed from the table by the poker room while sitting out.

For these reasons, plus the fact that our bots have been programmed to play well
short-handed, we don’t recommend using this option for anything other than
high-stakes cash games. Please make sure the sitout option is set to <1 before
using it the first time.

The sit-out option is automatically ignored in tournaments of all types.

Max Session Time

On the option menu of our pokerbots you can choose to have them quit after a
certain number of hands or after a certain time has elapsed. This comes in handy
when you are leaving for work or going to bed and want to control the playing
session time, which is always a good idea (to keep from being profiled as a
possible bot user).

Playing Sessions

Now, you could let the bot run for days or even weeks on end. But that would be
foolish wouldn’t it? Not only would you possibly flag your account and cause
troubles for yourself, but it could even result in causing problems for the rest of
us. Please bot responsibly. Playing 10-12 hour days with 8-12 hour breaks in
between is reasonable. Take a day off now and then as well.

There are several ways to set the max session, including by when your stack
size reaches a certain level so you can book a win and walk away. See the
instructions text file for more detailed information.

Bathroom Breaks

The Hold’em Bot comes with a bathroom break scheduler and it is recommended
to use this feature in cash games. The bot will sit out for two or three minutes
then sit back in. This can be scheduled as often as you like. However we
recommend three minutes every 90 to 120 minutes. Be sure to turn it off in



tournaments (this is done by making the interval time higher than your max
session time).

Avoiding Being Profiled

Because our bots are programmed to take different actions in the some of the
same scenarios based on random elements, and because there are quite a few
user option settings which can be changed for No Limit play, they are difficult to
profile. They also play well short-handed so it's hard to get pegged as a bot and
be exploited for it. Still, it's a good idea to play without the bot once in a while just
to keep players who are taking notes on you off kilter. (At the lower limits this isn’t
something you should even be concerned about.)

Poker Room Upgrades

From time to time a supported poker room will upgrade their software in a
manner that temporarily breaks the bot. This is no time to panic! Rest assured
that we probably already know about it and are working on the fix. Watch our
forum announcements and/or subscribe to our RSS feed for the announcement
of when you can download the upgrade.

Our Forum URL: www.bonusbots.com/forum

Our RSS Feed for Updates: www.bonusbots.com/updates/feed

The Rake: Your Worst Enemy

Most poker players completely underestimate their most formidable opponent,
the rake. The rake always ends up with the most money over any reasonable
time period. It's like an opponent who is guaranteed to book a big win every
single time you sit down at a poker table. And that makes things very tough!
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Consider this: A game where the average stack is $150 and the average rake is
just $.60 per hand, dealing 65 hands per hour. This is typical of many online
games. In 23 hours the rake will have taken every single chip on the table.
That’s right, all of it. You can’t imagine how profitable the larger online poker
rooms are. And you had better understand that this is a near-impossible
proposition to escape from, unless:

A) your opponents are playing terribly, and/or
B) you are getting a significant portion of that rake back through bonuses and/or
rakeback.

Full 9 and 10-handed games are one way to help curb the sting of the rake. It's
cost is significantly less at these tables, as more players share in the bill and the
blind pressure is less. This means that you can play tighter and be rewarded for
it. (That’s why our Hold’em bot plays extremely tight in full ring games.) The
drawback is, only good players seem to understand this and so the full 9/10
tables just don’t have a lot of bad players in them any more. That’s a real
problem.

Another way to escape the rake is to play tournaments, especially multi-table
tournaments (MTT’s). There is so much dead money in these things that you
don’t need rakeback or bonuses to profit from them nicely. Dead money is a term
that refers to people who have no chance of finishing high, and MTT’s always
have enough of them to more than cover your entry fees.

Even SitNGos (SNG’s) can be a profitable way to avoid the rake at the lower
buy-ins. For example, $5 and $10 SNG’s have enough dead money — people just
messing around who aren’t really serious — to be quite profitable without needing
any bonuses or rakeback. As you move up to the medium and higher buy-in
games the dead money vanishes, however. But in those games all you have to
do is play solid and keep your cool in order to have an edge which negates the
entry fee, something that bots happen to excel at.

Allin all tournaments are an excellent way to escape the rake.

Finally, for those with the means and the stomach, high-stakes cash games can
be the route out of the rake’s devastating grasp. Once the average pot size is
significantly above the size where the max rake per pot is reached, it becomes
much less of a factor. In these games the players are all pretty good and so small
edges are obtained by those who don’t go on tilt or make stupid mistakes. Again,
this is something that our bot is a champion at.

However, high stakes games have other pitfalls, not the least of which is having a
tendency to become short-handed where it’s just you and a couple of the best
players in the world. Obviously you want to avoid that and so the sit-out option on
our bot should be used at these tables if you want to take a crack at them (we’d



also recommend sticking to limit). The other problem is that high stakes games
can become high-profile, something botters should try to avoid. But our bot
actually should do OK at high-stakes limit tables that stay full — just don’t play too
long.

Level of Competition

This is the final ingredient. Terrible players will pay your share of the rake as well
as theirs, and leave you a little something to boot. If there are a couple of them in
your game, rest assured that everybody will get paid. They are the life blood of
good online poker players, and even the best poker bot needs them in order to
be profitable. This is a critical concept.

In fact if there are not bad players frequently coming into your games, you are
not going to make a profit - with or without a great pokerbot. Even the poker
rooms with the best rakeback programs and bonuses are not giving it all back.
There will be a small deficit to make up, and the bot will need poor players
making frequent poor decisions in order to grind out an hourly profit. This is why
a table full of poker bots is simply not going to work, no matter what the rakeback
and/or bonus scheme is.

Without bad players, the best you'll be able to do is lose less than everybody
else. This is very important to understand. Seek out soft games. It's worth your
time. There are tools available to help you do this. Just having Poker Tracker can
be a tremendous resource. You can check in on your bot every now and then,
scan the tables for players with bad stats, change tables, turn your screen off,
and come back in an hour or so to repeat the process. This exercise, if you have
the ability to pull it off, will improve your results in cash games dramatically.

Bad stats are players with high $VPIP and low PFR%. In other words, they play
a lot of pots but don’t raise before the flop much. These are the kind of players
that will make the bot profitable, and it greatly behooves you to find them and sit
at their table. (The other stat you might check for is a low won at showdown
percentage, or perhaps just a high dollar loss for the number of hands you have
recorded on them.)



Multi-Tabling

Both our poker bots can currently play up to six tables at any of our supported
poker rooms (except Bodog where they allow a maximum of 4 tables per player).
This function works best on large monitors where you can separate the tables
farther, but even on small screens where the multiple tables obscure each other
it will work as long as the buttons themselves do not overlap. The exception
might be if you must Use OCR in order to play and also have a small monitor
(more on that below).

The bots can also multi-table between game types, although we do not
recommend multi-tabling while playing an MTT because the additional tables
open can trip up the bot when you experience a table change. Please note that
you cannot multi-table across poker rooms, either — all your tables that are open
must be at the same room.

The only thing you need to watch when multi-tabling are staggering your tables.
Separate your tables as much as possible without hanging them off the edge of
your monitor.

Table Positioning Tip: If you have a big screen you should try and position the
tables so that there is minimum overlap between them. On smaller screens you
should at least position the tables such that the button areas do not overlap.
Position the 2" table window such that it is a little (about two inches) to the right
of and a little (about 2 inches) below the 1% table and so on.

How to Multi-Table

A menu item named New Window can be found on the Holdem menu. Clicking
on this causes a new bot window to be opened up. The new window will ask for
the additional poker table name, which you should already be sitting at. You need
to type that in exactly as it shows in the poker window, as this is case sensitive.

A max of 6 bot windows can be open simultaneously. Each bot window acts
independently and can be used to connect to and play at a particular poker room
as per the rules above. Profiles need to be loaded independently in each window.
They can be hidden and brought up independently. They write in separate log
files. The log for the first window is called holdem.log (or om.log for the
Omaha/8bot) as usual. The log for the second is called holdem2.log and so on.
Each window is independent, so one can play Limit and another No Limit etc.
without getting confused.

Most people can hide all Bot windows on their machine when multi-tabling. This
is a sure way to speed up clearing bonuses and/or earning rakeback.



Custom Profile Creation

Our poker bots have an option menu where you can choose certain settings for
the type of game you plan on playing in (be it a tournament, short-handed cash
game, etc.). So that you don’t have to do this every time you change game types,
you can save your settings as a profile. This allows you to quickly load different
profiles and you can even load different profiles for different tables while multi-
tabling. Details on how to do this are given a bit further in this manual, as well as
in the instructions text file that came with our software.

The Hold’em bot now has over 30 individual settings on the option menu. If you
need help with setting suggestions for different game types, we maintain a thread
in our forum called Egor’s Favorite Holdem Bot Settings and it is publicly
viewable as a sticky post on the Discussion Board. Here is the link to it:

http://bonusbots.com/forum/YaBB.pl?num=1212365053

In addition to these option menu settings, our poker bots are now completely
user-programmable as well. We created a simple language that most poker
players can easily learn so you can completely program the bot’s entire playing
instructions to your liking, if you so desire. The language is known as PPL which
stands for Poker Programming Language.

Please note that this isn’t really necessary and many of our customers have
reported great results from profiles created using the option menu. But if you are
hardcore you might enjoy doing a bit of custom coding to your bot.

Also note that you don’t have to code an entire profile either. You can create
small snippets of PPL code just to handle one or two situations in a certain way
and use the option menu for the rest of the profile.

User-created custom code simply needs to be inserted on the saved profile
(which is a text file) underneath where you see the option menu choices
displayed. Please read the PPL User Guide that also came with your software
download to learn how to create custom code.

Stack Size Recognition

Our poker bots read their stack size from the poker table window when it is time
to act. They take this information into making certain decisions based on options
that you have selected. The stack size is read and recorded in dollar amounts.
However some of the settings on the option menu that include stack size ask you
to set it by number of big blinds. The bot does the conversion automatically. You


http://bonusbots.com/forum/YaBB.pl?num=1212365053

probably need to do a little calculating to figure out how to set the stack size by
number of big blinds for these settings.

Please note that these settings have a very high initial value, which means they
are always on for any stack size if you turn the above option on. To make the
above option only happen when your stack gets short you need to enter a

number that represents a short stack, for example 15 or 20 (15 or 20 big blinds is
a reasonably short stack in many situations).

Total Investment

The bot keeps a running tab of its total investment in any given hand. At least
one option menu setting allows you to set it by Total Investment. The purpose is
to keep from folding in situations when you are pot-committed.

Hold’em Bot Strategy

Get ready for some real fun. Most of our supported poker rooms offer substantial
deposit bonuses which can be worked off using the bot. Some of them also offer
rakeback deals through various affiliates. See the beginning of this use manual
for the list of currently-supported sites, and/or log in to our support forum to get
the scoop on the latest rakeback deals.

Games the Bot will Play

Our Hold’em poker bot will play the following types of games:
v' Limit cash games 6-max
v' Limit cash games 9-max or 10-max
v' Limit SNG’s
v Limit MTT’s
v" NL Cap cash games 6-max
v" NL Cap cash games 9-max

v" NL cash games 6-max



v" NL cash games 9-max or 10-max
v NL SNG’s

v NL MTT’s

v" PL cash games 6-max

v' PL cash games 9-max or 10-max
v PL SNG’s

v PLMTT’s

How’s that selection for you? Basically the bot will play any form of Hold’em
being spread in any structure. In order to accomplish this we had to give the bot
a different set of instructions for different game types, and we also decided to
include some user controlled options for certain types of games. Let me try and
break that down for you.

NL, PL, and NL Cap Games — the bot plays all these types of games the same
way, whether cash or tournament. The major differences between this type of
game and Limit Hold’em lies in calling raises, both preflop and post-flop, and also
in calling non-raised pots preflop. In this type of game the bot folds to raises that
it will call in Limit. It will also call the blind with small pocket pairs in this type of
game (trying to flop a set) whereas in limit it will almost never play those hands.

In NL and PL games there are some options that need to be set. Two of these
also affect Limit game play. | will give you some general guides in the strategy
section below, but for now let’s go over what they are. You can find these on the
Options menu of the bot program window.

Option 1: Set the Preflop Raise Size — You can set the preflop raise amount to
always be the minimum, always be pot-sized (about 3.5 x the big blind), or
sometimes bet the pot and sometimes bet the minimum based on either a
random element or hand strength. In low-stakes cash games | prefer to always
raise the minimum, in slightly higher stakes cash games | like to use one of the
random elements, in low stakes tournaments | prefer to always use the pot-size
raise, and in higher stakes tournaments | like to set it by hand strength.

Option 2: Set the Post-flop Bet Size — You can set the post-flop bet/raise size
by a % of the existing pot-size for the Flop, Turn, and River. For example you can
have the bot bet 75% of the pot on the Flop, 60% of the pot on the Turn, and
50% of the pot on the River.



Option 3: Fold to Preflop Raises for AQ, AJs, KQ - this is just what it sounds
like. The default position is off, meaning that if you do not check this option the
bot will call preflop raises when holding these three hands. In limit the bot always
calls one preflop raise with these hands but you can make it fold these hands for
a preflop raise in No Limit and Pot limit. Generally speaking | would recommend
keeping the default setting in lower stakes games and checking it on for higher
stakes games.

Option 4: Fold Post-Flop Below Top Pair to Any Bet or Raise — this is a post-
flop setting that will give the bot an overriding instruction to always fold any hand
below top-pair in strength to any bet or raise. You can leave this off and the bot
will play by the default instructions and sometimes call large bets with certain
drawing hands like a medium pair with a flush draw. Or you can check this option
and always be safe from donking off your stack to a large all-in bet when holding
anything under top pair.

Option 5: Fold to Postflop Raises with Unpaired Boards for — this is a post-
flop setting that will give the bot an overriding instruction never to call a raise with
a hand below the strength of your choosing. Note that this is only for non-paired
boards with no possible made flush and no possible made straight. The default
setting is top-pair best kicker, and that is the loosest possible setting (in limit the
bot will often call raises with any top pair or combination pair/draw hands). My
recommendation is to tighten this setting as you play higher stakes. I'd lean
towards checking this option in tournaments and higher stakes cash games.

Option 6: Fold to Postflop Raises with Paired Boards for — when the board is
paired what is the minimum strength hand you want to call a raise with? The
default setting is trips with best possible kicker. You can loosen this or tighten
this at your discretion. Again, in limit the bot will play a bit looser and | would
tighten this setting in certain higher-stakes situations.

Option 7: Never Bet Turn or River with Hand Below — (note this setting also
affects Limit games) here you can turn off the automatic continuation bluffs on
the turn, which is a good idea in higher stakes cash games and late stages of
tournaments, especially when you are close to the money. If you leave the
default setting the bot will make pot-sized bluffs on the turn when against one
opponent and the bot bet the flop and was only called and it’s first card is a
certain color. Setting this option to at least second best pair is probably a good
idea for tournaments and all but the smallest stakes NL games.

Option 8: Never Bet Flop With Hand Below Middle Pair When — (note this
setting also affects Limit games) you can turn off all flop continuation bets with
this setting. However it is not recommended that you use this setting unless you
really know what you are doing.



Note that one of the options is to turn it off when your stacks size falls below a
certain level, and that is probably the best use for it (in a tournament situation).
When your stack is getting small you don’t want to waste chips on pot-sized bets
stabbing at the flop and are really just looking for hands to push with pre-flop.

This setting is for experts only. You are usually making a big mistake by not
automatically betting the flop when you were the last preflop raiser.

Option 9: Never Call Paired Boards with Hand Below — by default the bot will
call one bet on certain paired boards with good two-pair hands, especially when
the board pair is small and the two pair hand is of the highest other board card or
better. With this setting you can tighten that up, which might be a good idea in
higher-stakes cash games.

Option 10: Never Call Flush Possible Boards with Hand Below — by default
the bot will call one bet with certain hands when a flush is possible, especially
when two cards are needed for a flush and the bot has a decent hand against
only one or two opponents. With this setting you can tighten that up, which might
be a good idea in higher-stakes cash games.

Option 11: Fold to Preflop Raise with 55 or 66 when — set how the bot will
handle these two hands preflop when there is a raise. If you leave it in the default
position it will sometimes get all-in with them preflop, which is a good idea when
you are short-stacked in tournaments — but not any other time really.

Option 12: Fold to Preflop Raise with 77 or 88 when — these hands are
somewhat better than the above two, and this option will allow you to set how
they handle preflop raises. In cash games it's probably a good idea to fold them
for a raise. If you leave this setting in the default position the bot will always
reraise and try to get all-in with them preflop (which is a good setting for
tournaments).

Option 13: Fold to Preflop Raises with 99 or 10-10 when — these hands are
significantly better than the above two, and this option will allow you to set how
they handle preflop raises. In cash games it’s probably a good idea to fold them
for two raises. If you leave this setting in the default position the bot will always
reraise and try to get all-in with them preflop (which is a good setting for
tournaments).

Option 14: Fold to Preflop Raises with JJ or QQ when — these hands are
significantly better than the above two, and this option will allow you to set how
they handle preflop raises. In higher-stakes cash games it's probably a good idea
to fold them for two raises. If you leave this setting in the default position the bot
will play them very intelligently, usually trying to get all in but backing off for a lot
of action when out of position.



Option 15: Fold to Preflop Raises with AK when — one of the strongest preflop
holdings in a tournament, but somewhat vulnerable in a cash game. In higher-
stakes cash games it's probably a good idea to fold for two raises. If you leave
this setting in the default position the bot will play AK very intelligently, usually
trying to get all in but backing off for a lot of action when out of position.

Option 16: Fold to Preflop Raises with AQs when — this hand has roughly the
same value as AK (offsuit), but presents more challenges in playing correctly. In
general you should be less willing to get all-in with it in tournaments preflop, and
be wary of too much preflop action in cash games. Some players like to tighten
up with this hand. We recommend folding for two raises with it in cash games
and the early stages of tournaments.

Option 17: Fold to Preflop Raises with AKs —don’t ask me why we are even
giving you this option. We just threw it in there. Some experts might want to fold
for two raises in certain game environments | suppose. Recommend leaving this
in the default position.

Option 18: Fold to Preflop Raises with KQs — probably a good idea to fold for
two raises in cash games but play by default when short-stacked in tournaments.

Option 19: Fold or Go All-In when Opponents (After Folds) Less than — This
feature will have the bot simply click the max button and go all-in anytime it has a
playable hand. That includes a calling hand or a raising hand, the only exception
being when it is in the big blind with a folding hand and gets a free look at the
flop. In that case the bot will then go All-In after the flop in any situation where it
would call or raise. You can set this for always, or by the number of remaining
opponents. If you choose a number of remaining opponents then you would still
be playing normal against a higher number of opponents. Believe it or not, using
this setting in the Always position can be an effective way to play tournaments.

You can also set this option to apply only after a specified number of hands in
your session has expired, which can be very effective in multi-table tournaments.
Figure on about 50-60 hands per hour being dealt when deciding when to have it
kick in.

Finally, you can also set this option to trigger only when your stack size is below
a certain level.

Option 20: Fold or Go All-In when Opponents at Table Less than — This is
the exact same feature as option 16 above, except that it is triggered by the
starting number of opponents instead of the remaining number. In other words,
the original number of opponents sitting at the table. If option 16 above is
chosen, the bot may very well push all-in on the first hand of a tournament.



By contrast, if you want the bot to only start pushing all-in when down to the last
few players of a SitnGo (or multi-table tournament) then this is the option you
want. Frankly, we see that as a good idea for all types of NL Tourneys. (The bot
will still fold and check it's non-playable hands).

You can also set this option to trigger only when your stack size is below a
certain level.

Please note that both Fold or Go All In options should not be turned on at the
same time. Choose one or the other, or use the Aggressive Tournament Setting
instead.

Option 21: Always Call When Opponent’s Raise is Less than — because you
don’t want to fold for very small raises after you make a large bet in NL or PL
games, the bot won't let you. It will always call a raise from an opponent that is
less than 40%, 30%, or 20% of the amount of the bot’s last bet (or raise). Which
percentage is up to you. For most tournaments you probably want to set this to
40%.

On the river, there is a minimum hand strength requirement that you have at
least best kicker or better before calling the small raise. For all other betting
rounds however the bot will call small raises with any hand that it had bet with.

This feature also extends to the next betting round. The bot remembers when it
was the last bettor or raiser on the previous betting round and if somebody bets
their last few chips out it will treat that as a raise on the previous betting round
and apply these settings.

Included on the window for this setting is the most important incorporation of
Stack Size Recognition, being able to compare it to Total Investment. The
option reads:

Always Call when Stack Size is Below

...and lets you set the percentage. It's important to understand what the
percentage setting means. You are setting your stack size as a percent of total
investment in the hand. The initial value is set very low at 30%. That means if
you have $1,000 in chips invested in a hand but only have $400 left in your stack
the bot will still fold to many raises protecting your last $400 because that is 40%
of the amount you have invested in the hand. However if you had this set to 50%
then the bot would always call any bet or raise if you only had $400 left in this
situation.

So what this setting does is override all folding action to calling once you have
put a certain amount of your stack in a pot. Some people think they are pot-



committed whenever they get half of their stack or more into any given hand,
especially in SNG’s. In that case you would want this setting at 100%.

Remember the bot makes a comparison of your current stack size to the
amount you have invested in the hand. So if you got 50% of your stack in
on a given hand that would mean the total Investment now equals 100% of
your current stack size.

Option 22: Super Tight Play — (note this setting also affects Limit games)
this setting will have the bot fold all hands preflop except: AA, KK, QQ, JJ, 10-
10, 9-9, AKs, AK, AQs, AQ, AJs, and KQs which it will play normally. Some
people like to have the bot play the first half of a tournament for them with this
setting before taking over themselves.

Option 23: Semi-Super Tight Play — (note this setting also affects Limit
games) the same thing as Super Tight Play above but includes all pocket pairs.
Note that the bot will play them by default programming with this setting, which
only includes calling minimum raises when holding the smaller pocket pairs. You
can use the Set Mining option below in conjunction with Super Tight to call larger
preflop raises with smaller pocket pairs if you so desire.

Option 24: Minimum Bet Override — this setting stops opponents from making
a minimum bet into a large pot to get the bot to fold without incurring any risk on
their part. It is invoked anytime that an opponent makes a post-flop minimum bet
(exactly 1 big blind in size) in a No Limit or Pot Limit game environment where
the pot is at least 5 big blinds in size and your hand value is best high-card
or better. You can choose how you want to handle this: Call all post-flop
minimum bets, raise minimum sometimes and fold sometimes, or raise minimum
sometimes and call sometimes.

We recommend always calling in tournaments, and raising minimum sometimes
and calling the rest of the time in cash games. Please note that this setting is in
the default position when you downloaded your bot which will not recognize
minimum bet sizes, so you do need to change this one to your preference.

Option 25: No Limp — (note this setting also affects Limit games) if you hate
limping this setting is for you. We added it after some of our customers shared
their Poker Tracker databases with us, making a strong argument against ever
limping at all in cash games. While we aren’t quite sold on that concept, we do
think it's a good option for most 6-max cash tables. (There aren’t very many
hands the bot will limp with anyway, especially while playing short-handed.)

The setting affects every position except the Big Blind, and when activated will
never just call the blind preflop. You can choose how you want to handle the few
hands that it would normally limp in with. There is an interesting setting that will



raise if less than two callers otherwise fold. Note that this setting only affects
hands where bot is instructed to call — it will not start playing any hand that
way!

Also, the setting is only invoked the first time around the table. After you have
raised the bot will then call reraises if it is supposed to (with hands like AK and

QQ).

Option 26: Aggressive Tournament Setting — this is highly recommended for
tournaments of all types and sizes. Playing cash games requires a different
approach than playing tournaments (with the possible exception of really small
stakes cash games). When this option is left in the default position the bot will
fold many decent hands for a large bet size. That’s the best way to play most
cash games above the micro limits. However in tournaments you are going to
want to shove all-in with many of those same hands that you want to fold in a
cash game. That’s what this setting does - it uses the Bet Max button in NL
games when it holds a good hand. There are two sections to this setting and one
selection must be made in each of them.

Preflop section. Here you can choose from among a half-dozen hand lists that
the bot will simply shove all-in with preflop. The first one on the list consists of
only the very top starting hands and also requires at least one preflop raise
before it will shove. The rest of them get progressively looser and do not require
a preflop raise. In general, the earlier in the tournament and/or the bigger stack
you have the closer to the top you want this preflop section set - and vice-versa.

Postflop section. This side only has two choices (other than off). The setting
refers to the post-flop conditions for which the bot will bet or raise all-in. These
are not defined for the user. We programmed the bot to push with any decent
post-flop hand when this setting is invoked. This includes top pair or better on
non-scary boards and reasonably strong hands on scarier boards. Your only
choice when you turn this on is whether you only want to shove all-in when the
conditions are met if there was a preflop raise, or whether you want to shove
all-in regardless of whether or not there was a preflop raise. In general, the
earlier in the tournament and/or the bigger stack you have the more you would
want to require a preflop raise before shoving with any decent hand post-flop.

Stack size recognition. For both preflop and post-flop sections there is an
option to only invoke the setting when your chip stack falls below a certain level.
When you turn this on (by reducing the number of big blinds to a level that
reflects a short stack) the bot will only play by the Aggressive Tournament
Settings you have chosen when the stack size requirement is met.

For example you might set the stack size requirements at 20, as anytime you
have under 20 big blinds that is considered a short stack in a tournament. (You
might want to set both sides at the bottom level and set the stack size to 20 so



that anytime you get short-stacked you just start pushing all-in with reasonable
hands.)

Option 27: Mining for Sets — the default instructions for calling raises preflop is
to fold for raises 4 big blinds or higher with 22 through 66 and to fold for raises of
6 big blinds or higher with 77 through 99. This setting allows you to override the
default instructions and always have the bot call with 22 through 99 up to a raise
amount that you choose. In deeper stack games it might be a good idea to set
the number around 7 or 8.

Option 28: Post-Flop In Blinds Override — (note this setting also affects
Limit games) in Texas Hold’em you often get a free look at the flop from the big
blind position. Sometimes that means you flop top pair with a weak hand such as
10-3. By using this setting you can tell the bot you basically don’t want to get
involved in these pots without having a good hand, that is at least top pair with a
decent kicker. There are two choices: Second best kicker or better, or third best
kicker or better.

When you check this setting on it will simply give up on all other hands from
either blind position as long as there was no preflop raise. These are situations
when you have nothing invested. If there was a preflop raise the setting won'’t be
invoked and the bot will play as normal, since you do have something invested in
that case.

The drawback to this option is that the bot will also abandon continuation bets on
the flop when it was the last preflop raiser as well. However this might be a good

way to randomize backing off on your aggressiveness a little, since you are out of
position on these hands.

Option 29: Preflop Reraise Override — (note this setting also affects Limit
games) if you only want to reraise (that is 3-bet or 4-bet) with aces or kings,
check this setting. It is one that simply turns on or off with a check mark. When
on, the bot will only reraise preflop with AA or KK and just call with the other
premium hands which it would normally reraise with.

Option 30: Auto Rebuy at UB and Bodog — when you go broke in a cash game
at these two rooms a window pops up asking if you want to buy more chips. By
checking this option on the bot will click the Rebuy button and then click OK on
the box that pops up. Note that this will only rebuy for the amount suggested by
the poker room software which may not be the maximum.

Saving Your Options As a Profile — For convenience, you can now save your
option settings as a profile, which becomes a text file that is stored in the same
folder your bot program is kept. That way you can quickly change option settings
when you change game environments. Don’t forget to have the bathroom break



setting on 900 minutes for tournament profiles and around 80-120 minutes for
cash games profiles!

To save a profile, click on the first item on the main menu Holdem: Write Profile.
A window will appear with the default name "holdem_profile.txt." You will want to
rename this to something easy to remember when loading your profile. (Please
note that the .txt extension must remain.) For example, cash.txt or sng.txt.

To load a saved profile, go to Holdem: Read Profile... then just type in the name
of the saved profile that you want to load. You will get a confirmation message in
the bot window that your profile loaded, along with all the options set for that
profile.

Auto Switching Profiles — You can also set the bot to change the profile it is
using based on a preset condition. The conditions you can use for loading a
different profile are:

» Shorthanded table by number of players sitting at it
* Number of hands played in the current session

» Number of minutes expired in the current session

« Stack size has fallen below a certain level

This is a very useful feature, as you probably want to use a different profile in a
short-handed game than at a full table, or switch to a push-or-fold type profile
when your stack is short. Also, some players like to play the first two hours of a
tournament very conservatively then become very aggressive (or vice versa).

To set up the the profile auto-switch, on the bot’s main menu go to:
Holdem > Auto Read Profile

Then enter the saved profile file name (or path) and set the criteria for when you
want it loaded.

Rakeback

It's important that you open up your accounts through our recommended
rakeback provider below. If you already have accounts at all our poker rooms
and thus cannot get the rakeback, | would recommend playing tournaments only.
This bot does extremely well in the tourneys, making the money often. Every
once in a while the poker room will throw you a bone in the way of a surprise
deposit bonus. These surprise bonuses should be cleared in the cash games.

Signup at Rakeback Organizers, using this link:
http://tinyurl.com/2tngad



http://tinyurl.com/2tnqad

Strategy

Note: the recommended settings for the strategies below do not include all
the wonderful new settings we have added since this manual was originally
written. However you should still read through it to get a feel how the
settings can be adjusted for the various game types that are available.

For a more updated list of recommended settings for different game
environments please visit this forum thread:

http://bonusbots.com/forum/YaBB.pl?num=1212365053

There are a lot of ways to go at these poker rooms. I'm sure you can find
something that works for you. However we strongly advise focusing on No Limit
and Pot Limit rather than Limit games.

The edge that solid players have over poor players in No Limit is gigantic. In limit
the fish live longer because they aren’t usually taking that much the worst of it
due to pot odds. But in No Limit they often get their whole stack in there as a 3-1
underdog or worse. This more than makes up for the lack of bonuses.

| am going to divide the specific strategies into two parts: Semi-monitored and
Non-monitored. The semi-monitored section assumes that you can check in on
the bot frequently, maybe once or twice an hour. This option is good for people
who can put an extra PC on their desk at work (perhaps via a KVM switch so
they can use the same monitor, keyboard, and mouse).

Going the semi-monitored route will improve your cash game results, no two
ways about it. You will need extra software to get the most from it. The best bet is
purchasing Poker Tracker 3, which use can use to data-mine many tables when
you are not playing or using the bot. Then all you need to do is start keeping a list
of currently active players who have:

* High $VPIP Numbers (above 45 is best)

* Low PFR% Numbers (below 7 is best)

These players will be putting lots of money into post but hardly ever raising. If
you always make sure at least one of them is at your table you should do very

well in your online poker career, with or without a bot.

If going to these lengths is not something you are able or want to do, don’t worry.
The bot will do just fine playing the PL and NL cash games and all manner of


http://bonusbots.com/forum/YaBB.pl?num=1212365053

tournaments in a completely un-monitored fashion. However, | would recommend
avoiding the limit and cap games if you are not using extra software to do
frequent table-hopping.

Semi-monitored Strategies

Here are my recommended games and corresponding strategies for using the
semi-monitored botting approach.

NL Cap Cash 6-Max

While the 9-max tables are cheaper in rake, the 6-max tables are richer in
maniacs - one of the easiest kind of fish to beat. NL Cap 6-max seems to be a
really good game for letting the maniacs blow off their chips. In my personal
testing it was an excellent fit with Poker Usher, and | saw some impressive
upswings in the lowest limit game (.05/.10 blinds $10 max buy in).

Strategy — Buy in for the max. If playing at UB you will have to check back
frequently to buy-in manually when you lose your stack), check in once or twice
per hour to move to the most profitable looking table. Take the time to run
through all the tables a couple times per day and buddy-list players with high
losses, $VPIP over 45, and PFR% under 7. Use the games that your buddies are
in as targets regardless of where the tables rank on Poker usher, and especially
target games with 2 or more buddies.

Preflop Raise Size - recommend random pot-sized

Folding to Preflop Raises — recommend checking to on

Folding to Postflop Below Top Pair — recommend leaving off

Calling Raises Post Flop — recommend any two pair

Calling Raises Paired Boards — recommend trips best kicker

Never Bet Turn or River with Hand Below — recommend top pair

Never Bet Flop with Hand Below Middle Pair— recommend play by default
Never Call Paired Boards with Hand Below — recommend play by default
Never Call Flush Boards with Hand Below — recommend play by default
55 and 66 — recommend fold for one raise

77 and 88 — recommend fold for one raise

99 and 10-10 — recommend fold for two raises

JJ and QQ — recommend play by default

AK and AQs — recommend play by default

AKs — recommend play by default

KQs — recommend fold for two raises



Limit Cash 9 or 10-Max

Limit actually works very well with table-targeting, and there are enough full 9/10
handed tables going to make this work. In these games you enjoy a much lower
rake paid per hour along with decreased blind pressure. Our bot plays extremely
tight at these tables and punishes opponents who get involved with our solid
holdings.

Strategy — Buy in for about three times the suggested amount. Check in one or
two times per hour to move the bot to the most profitable looking table. Just go
with the tables at the top of the Poker Usher list, but do check them to make sure
there are significant stats on the opponents. Anybody with a 45+ $VPIP and a
PFR% under 7 after 80 or so hands is a reliable target.

Singe-table SNG’s

You don’t need any extra software for this approach. You just need to keep
checking in several times per hour to get the bot started in another SNG when
the last one is over. Glamorous? Perhaps not. Profitable? You bet! This actually
might be the single best use for the bot, as it's great at these things.

For NL and PL SitnGo’s:

Preflop Raise Size - recommend pot-sized

Folding to Preflop Raises — recommend leaving off

Folding to Postflop Below Top Pair — recommend checking on

Calling Raises Post Flop — recommend top pair

Calling Raises Paired Boards — recommend trips best kicker

Never Bet Turn or River with Hand Below — recommend default settings
Never Bet Flop with Hand Below Middle Pair— recommend play by default
Never Call Paired Boards with Hand Below — recommend trips

Never Call Flush Boards with Hand Below — recommend trips

55 and 66 — recommend fold for one raise

77 and 88 — recommend fold for two raises

99 and 10-10 — recommend play by default

JJ and QQ — recommend play by default

AK and AQs — recommend play by default

AKs — recommend play by default

KQs — recommend play by default

Aggressive Tournament Settings — both sides on, preflop in an upper middle
position and post-flop in the second position



Strategy — Play within your bankroll but don’t be afraid of the higher limits if you
can afford them. | would try to maintain an account size of at least 20 buy-ins to
handle the swings. Experiment with the option settings at different buy-in levels.

Tournament Starter

You don’t need any extra software for this approach. As an MTT player you are
simply going to let the bot do your grunt work to get you to past the middle stages
of a tournament and then take over.

For NL and PL tournaments:

Preflop Raise Size - recommend pot-sized by hand strength

Folding to Preflop Raises — recommend leaving off

Folding to Postflop Below Top Pair — recommend checking to on

Calling Raises Post Flop — recommend top pair best kicker

Calling Raises Paired Boards — recommend trips best kicker

Never Bet Turn or River with Hand Below — recommend 2" top pair+ overcard
Never Bet Flop with Hand Below Middle Pair— recommend play by default
Never Call Paired Boards with Hand Below — recommend trips

Never Call Flush Boards with Hand Below — recommend trips

55 and 66 — recommend fold for one raise

77 and 88 — recommend fold for two raises

99 and 10-10 — recommend play by default

JJ and QQ — recommend play by default

AK and AQs — recommend play by default

AKs — recommend play by default

KQs — recommend fold for two raises

Aggressive Tournament Settings — both sides on, preflop in an upper position
and post-flop in the first position

Strategy — Play any MTT you have a notion to play, be it NL, PL, or Limit. Put
the bot in and check back in 1-3 hours, depending on how large the field was.
Stay away from the turbo multi-table SNG’s, as what you are trying to do is
capitalize on your tournament skills and those are more of a crap shoot. When
the bot gets to a point and chip position that you want to take over the reigns at,
step in and finish the job. If the bot busted out enter another one and go back to
the hot tub. | like to take over at the bubbles (near the money or near the final
table). Also, when the bot is a huge chip leader early or middle | will sit it out for a
while.



NL Cash Games

This is my last choice for semi-monitored strategies and my first choice for non-
monitored strategies. The reason is this: | don’t think the edge you get from wise
table selection means as much in no limit cash games. Especially at the lower
limits where the games are all pretty juicy anyway, and especially the 6-max
tables. | might be wrong. Truth be told | haven’t tested it much so my opinion
might change. But the player base is so large at these that you might have a
difficult time gathering usable stats.

Preflop Raise Size - recommend AK or better

Folding to Preflop Raises — recommend checking to on

Folding to Postflop Below Top Pair — recommend checking to on
Calling Raises Post Flop — recommend any overpair

Calling Raises Paired Boards — recommend trips best kicker
Never Bet Turn or River with Hand Below — recommend top pair
Never Bet Flop with Hand Below Middle Pair— recommend play by default
Never Call Paired Boards with Hand Below — recommend trips
Never Call Flush Boards with Hand Below — recommend trips
55 and 66 — recommend fold for one raise

77 and 88 — recommend fold for one raise

99 and 10-10 — recommend fold for two raises

JJ and QQ — recommend fold for two raises

AK and AQs — recommend play by default

AKs — recommend play by default

KQs — recommend fold for two raises

Strategy — Buy in for the max, set your auto rebuy option for the max. If playing
at UB you will have to check back frequently to buy-in manually when you lose
your stack), check in once or twice per hour to move to the most profitable
looking table. Take the time to run through all the tables a couple times per day
and buddy-list players with high losses, VPIP over 45, and PFR% under 7. Use
the games that your buddies are in as targets regardless of where the tables rank
on Poker usher, and especially target games with 2 or more buddies.

Non-monitored Strategies

Stick the bot in a game, turn it on, check back in 10-12 hours. This is real botting,
and the reason many of you are interested in this product no doubt. | have a very
different hierarchy of strategy preferences for this approach. Here they are.



NL Cash 6-Max Maximum Rebuy

The preferred method to play NL cash games on complete auto-pilot. The action
players gravitate toward the 6-max tables, so even with the higher rake they are
more profitable when the betting gets bigger. This is because your opponents are
much more likely to donk off their stack than they are at the 9-max tables.

Preflop Raise Size - recommend AK or better

Folding to Preflop Raises — recommend checking to on

Folding to Postflop Below Top Pair — recommend checking to on
Calling Raises Post Flop — recommend best possible overpair
Calling Raises Paired Boards — recommend trips best kicker
Never Bet Turn or River with Hand Below — recommend top pair
Never Bet Flop with Hand Below Middle Pair— recommend play by default
Never Call Paired Boards with Hand Below — recommend trips
Never Call Flush Boards with Hand Below — recommend trips
55 and 66 — recommend fold for one raise

77 and 88 — recommend fold for one raise

99 and 10-10 — recommend fold for two raises

JJ and QQ - recommend fold for two raises

AK and AQs — recommend play by default

AKs — recommend play by default

KQs — recommend fold for two raises

Strategy — Buy in for the max and set your auto rebuy option for the max. If
playing at UB you will have to check back frequently to buy-in manually when you
lose your stack). The maximum allowed buy-in for your game should be no more
than 5% of your account size, and even that might be pushing it.

NL Cash 6-Max Minimum Rebuy

The problem with an in-between rebuy strategy is extremely high variance. For
example, in the $10 max games if you rebuy for $4 you will have many losing
days and one huge winning day every now and then that makes it all back. This
is because the bot will be constantly building a stack to $8, $12, $16, even $20
and then losing it all in one hand to another big stack in the game and starting
over.

This actually wouldn’t be a bad semi-monitored strategy, if you kept checking in
and leaving the game every time you had accumulated a decent stack - say 3
times your rebuy amount. Then just change tables and start over. That way you
keep bagging profits and lowering your risk.



A maximum buy-in amount approach doesn’t suffer from this problem because it
has so many opponents covered. It is starting with a much higher stack and
therefore isn’t trying to win 4 or 5 coin-flips in a row to stay in business. If you
let the bot run with a middle buy-in amount you will probably get frustrated with
your short-term results.

A minimum buy-in approach, on the other hand, is much better! This will reduce
your short-term variance while still giving yourself a shot at huge profit days
relative to your risk. So to recap, go with a minimum or maximum buy-in strategy,
but not with any amount in between.

Preflop Raise Size - recommend 99 or better

Folding to Preflop Raises — recommend leaving off

Folding to Postflop Below Top Pair — recommend leaving off
Calling Raises Post Flop — recommend top pair

Calling Raises Paired Boards — recommend trips

Never Bet Turn or River with Hand Below — recommend top pair
Never Bet Flop with Hand Below Middle Pair— recommend play by default
Never Call Paired Boards with Hand Below — recommend trips
Never Call Flush Boards with Hand Below — recommend trips
55 and 66 — recommend fold for two raises

77 and 88 — recommend play by default

99 and 10-10 — recommend play by default

JJ and QQ — recommend play by default

AK and AQs — recommend play by default

AKs — recommend play by default

KQs — recommend play by default

Strategy — Buy in for the minimum and set your rebuy option for the minimum as
well. The advantage to this approach is that you can play much higher for your
account size, taking shots in larger games with relatively little risk. Definitely give
this strategy a try sometime. Experiment with the option settings at the different
stakes, always leaning towards playing tighter the higher you go.

Large Field MTT’s

In my opinion, this is where the real money is in online poker. You don’t need a
rakeback deal and you don’t need a bonus. | have neither going for me, and | let
this bot steadily increase my account balance month after month. It rocks.

For example, as | was writing this manual tonight | had the bot play in a 90-player
knockout turbo SNG with a $2 buy-in. The bot finished 4™ and it’s total return with
the knockout bounties was $89. (Please note that this is not the recommended
game for this strategy, just giving a real-life example.)



As already discussed, large-field MTT’s have a significant number of players that
cannot finish in the money. They provide the dead money that finances the pros.
That’s why there are websites offering staking deals to online tournament players
who are any good at all. This bot can not only finish in the money, but it can take
first to win the tournament.

Using our Hold’em bot to play MTT’s, you can win satellites which you can then
parlay into big-money scores. You can win awesome vacations for your family.
You can end up on ESPN playing at a crazy final table somewhere. It’s all
possible from MTT’s, and the bot you downloaded with this manual can get you
there all by itself. Seriously. The biggest obstacle for most people realizing this
dream is time. With our bot that problem is solved. Sooner or later you will make
that big score using it. It's just a question of when.

For NL and PL tournaments:

Preflop Raise Size - recommend pot-sized by hand strength 99 or better
Folding to Preflop Raises — recommend checking to on

Folding to Postflop Below Top Pair — recommend checking to on

Calling Raises Post Flop — recommend top pair best kicker

Calling Raises Paired Boards — recommend trips

Never Bet Turn or River with Hand Below — recommend 2" top pair+ overcard
Never Bet Flop with Hand Below Middle Pair— recommend play by default
Never Call Paired Boards with Hand Below — recommend trips

Never Call Flush Boards with Hand Below — recommend trips

55 and 66 — recommend fold for one raise

77 and 88 — recommend fold for two raises

99 and 10-10 — recommend play by default

JJ and QQ — recommend play by default

AK and AQs — recommend play by default

AKs — recommend play by default

KQs — recommend fold for two raises

Aggressive Tournament Settings — both sides on, start high and adjust lower
as the tournament progresses.

Strategy — get the daily and weekly schedule of the big tournaments and work
up a plan of playing satellites for them. Learn when certain large-field daily
tourneys start that have a good reward for the buy-in. Develop a routine for the
ones you like. Try to stay away from multi-table SNG’s and go for the big payouts
instead. A large-field, scheduled tournament will last for 4-6 hours if you get deep
into the money, so you don’t need to check in all that often. Just know the
schedule of the ones you want to play and check in at the appropriate time to join
them.



NL Cash 9 or 10-Max Maximum Rebuy

This is a good way to go if you don’t have the stomach for a lot of variance. You
will be up against a tighter, more solid field of opponents than at the 6-max
tables, but our bot plays even tighter. This means that it doesn’t contribute much
in rake so it actually gets rake credits from the looser players. After the flop it
plays solid poker. All in all, the looser players will be paying your rake and your
profits will come from the bonus or rakeback, albeit at a slower (but reliable)
pace.

Preflop Raise Size - recommend AK or better

Folding to Preflop Raises — recommend checking to on

Folding to Postflop Below Top Pair — recommend checking to on
Calling Raises Post Flop — recommend best possible overpair (AA)
Calling Raises Paired Boards — recommend trips

Never Bet Turn or River with Hand Below — recommend top pair
Never Bet Flop with Hand Below Middle Pair— recommend play by default
Never Call Paired Boards with Hand Below — recommend trips
Never Call Flush Boards with Hand Below — recommend trips

55 and 66 — recommend fold for one raise

77 and 88 — recommend fold for one raise

99 and 10-10 — recommend fold for two raises

JJ and QQ - recommend fold for two raises

AK and AQs — recommend fold for two raises

AKs — recommend play by default

KQs — recommend fold for two raises

Strategy — Buy in for the max and set your auto rebuy option for the max. If
playing at UB you will have to check back frequently to buy-in manually when you
lose your stack). The maximum allowed buy-in for your game should be no more
than 5% of your account size, and even that might be pushing it.

Jackpot Targeting

Some poker rooms feature a bad beat jackpot. When a jackpot is hit every
person playing that same type of table and limit as the table that hits the jackpot
gets a share. In fact a full 25% is distributed this way. So if the jackpot is hit in the
.25/.50 NL game ($50 Max Buy-in and the most popular jackpot game by far),
everybody playing .25/.50 NL Hold’em splits 25% of the jackpot. These jackpots
get huge sometimes, and because the bot allows you to play for extended
periods you have a pretty good shot at getting some of this money.

Strategy — Wait until the jackpot gets high, like over $200,000 or so. Then play at
the most populated jackpot game your bankroll can tolerate, using one of the
strategies already listed above for cash games. Make sure you have a bonus to



clear or have rakeback going for you as well. If not, find out what the current
bonus offer is and make a deposit to get it.

Hold’em Bot Closing Thoughts

There are many more possible botting strategies for these two poker rooms than
what | have just written about. These are just a few that | have tried and like. |
haven’t even gotten around to the PL games yet. Who knows, maybe playing
those with certain options settings will prove to be the most profitable of all.

| don’t like the idea of using the minimum rebuy approach in a 9-max NL game.
Remember the bot does need to win a little from the weaker players to stay
above water, and it just seems like there won’t be enough opportunities to do that
in this type of slower-paced game structure when starting off with a tiny stack.

| believe that there won’t be enough bad play to make up for only a 27%
rakeback with no simultaneous bonus if you are not actively table-hopping to take
advantage of the worst players.

It's a good idea to adjust the options settings for the NL/PL games mid-stream
sometimes. Good poker players will often change speeds, and these option
settings will allow you to do just that. | especially like to do this in tournaments.
For example, in the beginning of a low stakes MTT | will often call preflop raises
with AQ, AJs, and KQ — but then turn that off when I get to the middle stages.

Shanky Technologies Team

www.BonusBots.com
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Appendix

Error Codes and How to Fix Them

Please note the bot will never display any of these error codes on most modern
Windows 7/8 systems if you have followed the Quick Start setup instructions

properly.

6.6 Error No 1: Version is not compatible

This error is given after Bodog upgrades their software. Such upgrades
temporarily break the bot. We normally post a new updated version of the bot
which fixes this problem within 48 hours of the upgrade. Bot upgrades can be
downloaded for free from http://www.bonusbots.com/hedownload.htm. Download
and install the new version of the holdem bot to fix this error.

6.7 Error No 2: You must run BOTH the bot
and the poker room as administrator

This is a Vista/W7/W8 specific error. You should never see this error on a
Windows XP Machine. For the holdem bot to work correctly, you must run both
the poker room and the bot as administrator. If you see this error, it means that
you are not running the bot as administrator. To fix this error, close the bot and
then restart it by right clicking on its icon and choosing “Run As Administrator”
from the pop up menu. You may also need to close the poker room and restart it
by right clicking on its icon and choosing “Run As Administrator” in the pop up
menu.

6.8 Error No 3: You must set style to Classic
on a Vista or Windows 7 machine

6.8.1 Windows XP

You should normally not see this error on a Windows XP machine. If you do see
this error, it is probably because you are running with a non-default “Active
Window Border” Size. To fix this error, right click on an empty area on the
desktop then choose Properties in the pop up menu. Click on the Appearance
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tab in the Properties dialog and then on the Advanced button. The “ltem:” list in
the Advanced dialog will show “Desktop”. Click on the arrow next to “Desktop”
and choose “Active Window Border” in the drop down list. Set the size to 1. Click
on Ok in the Advanced dialog and then on Ok in the Display Properties dialog.

6.8.2 Vista, W7, W8

If you get this error along with one of the other errors below then fix the other
error first and come back to this one, if you still get it after fixing the other errors.
To fix this error, set the theme to Windows Classic. To do this right click on an
empty area on your desktop, select Personalize in the pop up menu, then click
on Themes, then click on Modified Themes, and set the theme to Windows
Classic. Restart the bot.

If the bot still gives this error then you will need to change the “Active Window
Border” size. Right click on an empty area on the desktop then choose
Personalize in the pop up menu. In the dialog box that shows up, click on the
Window Color link towards the bottom middle part of the dialog box. A dialog box
titted “Window Color and Appearance” will pop up. The “Item:”list in this dialog
will show “Desktop”. Click on the arrow next to “Desktop” and choose “Active
Window Border” in the drop down list. Set the size to 1. Again click on the arrow
and choose “Border Padding” from the drop down list. Set the size to 0. Click on
Ok in the Window Color and Appearance dialog.

6.9 Error No 4: DPI Setting must be set to 96
dots per inch

6.9.1 Windows XP

To fix this error on a Windows XP machine, right click on an empty area on the
desktop then choose Properties in the pop up menu. Click on the Settings tab in
the Properties dialog. Then click on the Advanced button. Change the DPI setting
to 96 Bit in the General tab. Click on OK in the Advanced dialog and on Ok again
in the Properties dialog. Note that this change requires you to shut down and
restart your windows machine in order for it to take effect so you MUST restart
your machine after making this change.

6.9.2 Vista, W7, W8

To fix this error, right click on an empty area on the desktop then choose
Personalize in the pop up menu. In the dialog box that shows up, click on the
Display link at the bottom left corner. You will then see a screen titled “Make it
easier to read what’s on your screen”. On this screen select the option titled
“Smaller — 100% (default)”. Then click on the Apply button. A dialog box will



come up with the title “You must log off your computer to apply these changes”.
Click on “Log of Now” button. A detailed step by step process to change your DPI
setting on Windows7 machines along with screenshots is given at:

http://www.recipester.org/Recipe:Change DPI Size in Windows 7 25979243

6.10 Error No 5: Invalid caption height

6.10.1 Windows XP

On Windows XP this error could be due to an invalid DPI setting, invalid font size
setting or because you really have messed with the “Active Title Bar” size setting.

If the error is due to an invalid DPI setting then you will also get Error No 4.
Fixing that error should fix this one as well. So fix that first.

If you still get this error then the problem is likely caused by an invalid font size.
To fix the font size issue, right click on an empty area on the desktop then
choose Properties in the pop up menu. Click on the Appearance tab in the
Properties dialog. Set Font Size to Normal and click on Ok. Restart the bot.

If you still get this error then it is likely due to a non default “Active Title Bar”
setting. To fix that, right click on an empty area on the desktop then choose
Properties in the pop up menu. Click on the Appearance tab in the Properties
dialog and then on the Advanced button. The “Item:” list in the Advanced dialog
will show “Desktop”. Click on the arrow next to “Desktop” and choose “Active
Title Bar” in the drop down list. Set the size to 18 if you are using Windows
Classic theme and to 25 if you are using Windows XP. Click on Ok in the
Advanced dialog and then on Ok in the Display Properties dialog.

6.10.2 Vista, W7, W8

This error could be due to Error No 3 (Style is not set to Classic) or because of
Error No 4 (DPI is not set to 96 bits). If so, you will also get one of the above
error messages. Fix those first according to the instructions for fixing those
errors.

If on re-starting the bot after fixing the above errors, you still get this error
message then you will need to change the “Active Title Bar” size setting. Right
click on an empty area on the desktop then choose Personalize in the pop up
menu. In the dialog box that shows up, click on the Window Color link towards
the bottom middle part of the dialog box. A dialog box titled “Window Color and
Appearance” will pop up. The “Item:”list in the Window Color and Appearance
dialog will show “Desktop”. Click on the arrow next to “Desktop” and choose
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“Active Title Bar” in the drop down list. Set the size to 18. Click on Ok in the
Window Color and Appearance dialog.

6.11 Error No 6: Invalid color quality

Color quality must be set to 32 bit color. The bot automatically sets this for you so
you should never see this error. However if for some reason, the bot is unable to
make the change for you, you will need to do it manually. On Windows XP this
can be done as follows. Right click on an empty area on the desktop then choose
Properties in the pop up menu. Click on the Settings tab in the Properties dialog
and set Color Quality to Highest (32 bits) and click on Ok.

6.12 Display Settings Trouble-shooting.

If you are certain that all your poker room settings are adjusted correctly as per
the instructions below and the bot is not giving you any error messages on
startup but are still having trouble with the bot reading the buttons, getting invalid
opponent count messages, or mis-click reports, try the following:

Additionally (this is a Vista path but Windowes 7 is similar):

Click on START --> CONTROL PANEL --> Performance Information and Tools.
Under Tasks, click "Adjust Visual Effects".

Under the Visual Effects tab, make sure the option "Let Windows choose what's
best for my computer” is set. Do NOT set this to "Adjust for best performance.”




